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The march of technology never 

stops, so neither do we. Mac|Life’s 

website is now part of the new and 

improved TechRadar, so you can 

grab your fix of Mac and iOS news 

over at www.techradar.com.

You’ll get all the latest news and 

tutorials for Mac, iPhone and iPad, 

as well as other trusted reviews, 

news, and how-tos that have made 

TechRadar one of the world’s top 

tech sites. We’ll see you there!
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I’VE ACCUMULATED A lot more time 
with iPhone X since last issue, and the 
more I use it, the more excited I get 
about where the iPhone, as a platform, 
is heading over the next few years. 
That’s not to say the tech in this model 
isn’t fantastic — the TrueDepth 
camera, ace ID, the uid gestural and 
navigational changes resulting from 
the Home button’s removal, and 
Apple’s pushing of AR and machine 
learning are packed full of promise.

Now we’re in 2018, with Apple’s 
next Worldwide Developers Conference 
just a few months away and bound to 

deliver the next wave of evolution to developers’ tools, I’m hugely 
excited. More so than normal at this time of year, when Apple’s 
world can be a bit quiet. It feels like third-party developers have 
barely scraped the surface of what 2017’s software improvements 
allow, and interesting experiences should keep coming this year.

Apple issued human interface guidelines for AR apps only 
toward the end of last year. It’s clear that there’s an ongoing 
period of experimentation and learning when it comes to AR, and 
that building experiences around it might be more bleeding-edge 
than third-party iOS development involving a multi-touch glass 
surface was back at its inception a decade ago.

Must-have AR apps are thin on the ground right now, but I 
don’t see that as a sign of them being a passing fad. There’s a 
huge amount of potential for developers to tap into, beyond 
those that use machine vision to composite your image with 
new fashions, measure your home for new furnishings or a re t, 
or indulge your desire for computer-enhanced fun.

And if talk of the TrueDepth camera’s tech being extended to 
the rear camera in a future model proves true, as seems likely, 
then AR and machine learning, and apps built around them, are 
sure to be a key driver of future iPhone sales. But I’m getting 
ahead of myself. One thing’s for sure: the iPhone is in a great 
position to go from strength to strength throughout 2018, even 
before we reach the next hardware iteration.

THE iPHONE AHEAD

ALAN STONEBRIDGE, Editor

Twitter: @maclife

>>>THE TEAM

Craig Grannell
Contributor

Craig revitalized his Mac 

but still finds he works 

more on his iPad.

Matt Smith
Art Editor 

After years of solid grey, 

Matt is refreshing his 

desktop backgrounds.

Rosie Hilder
Operations Editor 

Rosie is hooked on the 

Scrabble app and is still 

trying to beat her sister. 
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EMAIL: letters@maclife.com
FACEBOOK: facebook.com/maclife  TWITTER: twitter.com/maclifeSHARE WITH US!

What do you 

want to see 

in iOS? Tell us 

at letters@

maclife.com

I’m a decades-long subscriber and faithful reader. Can’t 
tell you how many helpful tips I’ve followed, for which I 
never fail to be astonished and grateful. I’m having a 
few issues of slowness on my MacBook Pro and was 
keen to try the “essential support articles” you list in 

your Ask section — macOS Recovery, Safe Mode, etc. When I type in 
the addresses given, though, I get an error 404. What am I doing 
wrong? CHRISTIAN DICKERSON

We’ve checked that our bit.ly links are working, so our best guess is a 
typing error. Maybe it’s our sans-serif typeface that’s confusing things. 
All the links are along the lines of bit.ly/mlrecovery (that’s “ML” as in 
Mac|Life, only all lower-case), with no period at the end.

History starts today
I have been told that my 

external drive, used solely 

for Time Machine, needs to be 

reformatted each time a new 

macOS is installed. Is this 

necessary? STEVE RAFFIN

Doesn’t sound right to us, no. 

A key benefit of Time Machine, 

for major or minor OS updates, 

is the ability to start up in 

macOS Recovery and see a 

list of exactly which version of 

macOS was installed, and then 

roll back to a much older one if 

an unforeseen issue arises. 

Unless you’re using an SSD 

for Time Machine, which High 

Sierra will insist on converting 

to APFS, we’d leave it alone as 

long as possible.

The iPhone tech I’m 
looking forward to...
Lay off the gimmicks! I want a 

phone with long battery life, a 

decent camera, the ability to get 

local weather and news reports, 

and not much else. Hearing 

sticking issue for me is Boot 

Camp and the sad situation 

where I cannot easily switch 

from Windows to macOS 

because the bootcamp.exe 

taskbar icon no longer works, no 

doubt because the .exe cannot 

work with the new APFS filing 

system. I am happy to upgrade, 

but only once Apple releases a 

new bootcamp.exe in an update. 

I can’t understand why we are 

still waiting for this to be fixed. 

I am sure many other readers 

feel my pain. LEE BROMLEY

Apple still says the only way 

to use Boot Camp with High 

Sierra is to restart your Mac 

holding down the Opt key and 

use Startup Manager to pick 

between your Windows and 

macOS volumes. High Sierra 

seems to have broken so many 

things, though, some of them 

major security settings (see 

our Start section), that it’s 

anyone’s guess how long it will 

take Apple to get around to a 

fix for this particular issue. In 

the meantime, you could try 

alternatives like Virtualbox, 

covered in this issue. Anyone 

have anything else to add to 

the High Sierra wish list?

about a possible new iPhone SE 

is the first thing that’s given me 

hope. I want an iPhone that first 

of all is a phone, not a miniature 

computer with games, etc. 

Spare me. I’d like memory 

enough to store phone numbers, 

addresses, etc. but no gimmicks 

(like AR and millions of apps). 

Some connectedness with 

national and local news and 

weather is fine, but don’t 

overdo it. I don’t need iCloud 

connections, either. Make it a 

simple machine, like the first 

Macs were. I want ease of 

operation, please — and don’t 

always make things change. 

EMILY ENGEL

We hear you, Emily. It looks 

like Apple is committed to 

having a whole range of iPhone 

models available, so you can 

find the one that suits you. 

Back to Boot Camp
I upgraded to High Sierra 

upon its release only then to 

downgrade back to Sierra. The 

With High Sierra, switching between 

macOS and WIndows takes a restart.
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Apple sales 
stay strong

Market reports confirm strong 
performance in all sectors

BY ROSIE HILDER

APPLE REPORTED ANOTHER record result for its scal 
2017 fourth quarter (everyone else’s ), ended 
September 0, 2017. uarterly revenue was 2.  billion, 
an increase of 12  from the corresponding quarter of 
201 . There was growth in every business sector  even 
Mac sales were up 10  year-over-year.

The nances are ne, then. What’s particularly 
interesting is Apple’s market share. According to a report 
from Strategy Analytics, Apple remains king when it 
comes to smartphone sales in the S. The report data 
suggests that despite overall smartphone shipments in 
the S slipping by two percent in  2017, Apple still 
shipped 12 million iPhones in the States, giving it a 0.  
market share, with Samsung coming in second at 2 .1  
in the quarter. Worldwide, Apple sold .7 million 
iPhones in the quarter.

Of course, these gures don’t take into account the 
iPhone X, released in November. Apple’s own forward 

guidance is for revenue in the 
range of 8 -87 billion in the 
next quarter, but analysts 
suggest that thanks to the 
“X factor,” this estimate 
may prove to be conservative. 
Adam Levine-Weinberg from 
the Motley ool is predicting 
revenues of 0 billion and 
beyond. Trend orce predicts 
a boost in iPhone production 
volume and increased sales over 
the holiday period, leading to 
Apple overtaking the current 
leader, Samsung, in worldwide 
smartphone market share.

It’s not just phones, either. 
The same quarter also saw 
Apple back on top in the global 
wearables market, with Watch 
shipments of .  million. 
According to Canalys, this gives 
Apple 2  market share, beating 
former top-spot holder Xiaomi, 
which had 21 , and itbit’s 20 . 
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One size 
doesn’t fit all
The top-selling iPhone isn’t 
what you thought…

YOU MIGHT ASSUME that Apple’s newest 

iPhone will always be its best-selling, but it ain’t 

necessarily so. Market analyst Canalys looked at 

the numbers in Q3 2017 (Apple’s fiscal fourth 

quarter) and reports that iPhone 7 was the world’s 

top-selling smartphone in the quarter, with 

13 million units shipped. The iPhone 6S — originally 

released in 2015 — came in second, with 7.9 million 

shipments. The iPhone 8, which launched in mid-

September, did not even make the top five.

Sales of the iPhone 8 were strong, although not 

as strong as the iPhone 7 and 7 Plus on their 

release in the same quarter of 2016. In another 

twist, the iPhone 8 Plus outsold its regular-sized 

sibling, shipping 6.3 million units compared to the 

iPhone 8’s 5.4 million. This is the first quarter that 

a Plus model has outsold the standard version.

Of course, everything could change dramatically 

in the next quarter with the revised iPhone range 

including iPhone X and an iPhone SE 2 rumored 

for release early in 2018… But the strong sales of 

older models such as the iPhone 6S and SE 

suggest that Apple’s strategy of multiple models 

is appealing to buyers. As Canalys puts it, “Apple 

is clearly making a portfolio play here. With the 

launch of the iPhone X, it now has five tiers of 

iPhone and delivers iOS at more price bands than 

ever before. This is a new strategy for Apple.”

When it comes to tablets, global sales may be declining 
overall, yet Apple saw shipments rise 11.  year-over-
year to 10.  million iPads in , giving it a worldwide 
market share of 2 .8 , according to research by IDC. 
This is even more impressive when you notice that the 
number-two vendor, Samsung, had a market share of 
just 1  and su ered a 7.  drop in sales year-over-
year. Ama on came in third with a market share of 
10.  in the quarter. 

While it’s perhaps easier to pit one big tech company 
against another, it’s even clearer that Apple is on top 
when you look at operating systems overall. In the S, 
iOS has a market share of just under , compared with 
Android’s . . In Canada, the estimated gures are 
iOS 1.  vs Android . . In apan, you’re looking at 
iOS 7  vs Android 2. . 

DEVELOPING MARKETS

Sure, Android sells strongly in developing markets such 
as India, where you can buy a budget Android phone for 
under 100, but Apple revealed in its  earnings call 
that its revenue in India has doubled, and Bloomberg 
reports that the company’s iPhone assembler in India 
is seeking a location for a new assembly plant. Canalys 
reports that in China, after six consecutive quarters of 
declining sales, the iPhone 8 launch has seen iPhone 
sales rise by a dramatic 0  year-over-year. Apple is still 
only number ve in the Chinese market, but it’s the only 
non-Chinese brand in the top ve, and forecasters see 
promising signs for Apple in these key growth markets.

After its strong  earnings and bullish forecast for 
the holiday quarter, Apple’s market capitali ation topped 

00 billion in November 2017. As market observers 
noted, Apple is the rst publicly-traded S company to 
hit this highwater mark, and it’s looking like just a 
matter of time till it reaches the trillion-dollar level. It 
won’t be the rst company to do so, as ortune pointed 
out: “That distinction belongs to oil and gas producer 
PetroChina, which brie y topped 1 trillion on the 
Shanghai Stock xchange in 2007,” it reports, and 
Saudi state-owned oil giant Aramco is probably worth 
more overall. But Apple is currently the biggest public 
company in the world, and looks to be ever on the up.

There was growth in every business 
sector; even Mac sales were up 10% 

year-over-year

maclife.com FEB 2018 11



The shape 
of iPhones 
to come?
Apple looks to the future
BY STAFF REPORTERS

LAST QUARTER SAW the arrival of 
iPhone X, the most amazing iPhone 
since the original. But tech doesn’t 
stand still, and Apple certainly 
doesn’t. Some recent Apple patents, 
business moves, and rumors are 
hinting at what might be coming 
down the line.

One such rumor is that Apple is 
working on a dual SIM variant for the 
next range of iPhones, as well as 
pushing in some new gigabit LTE 
technology for faster internet.

Analyst Ming-Chi Kuo from KGI 
Securities — who has a good track 
record of predicting what Apple will 
do — has shared a report that claims 
the 2018 iPhone upgrades will 
include faster antenna modules. 
Instead of the current 2x2 antenna 
modules, new iPhones could feature 
a 4x4 MIMO setup.

While carriers and networks 
supporting gigabit LTE are few and 
far between at the moment, Apple 
including the new tech will 
future-proof these devices, and 
you’ll have generally faster speeds 
even before your network or carrier 
embraces gigabit LTE.

Kuo also says Apple may be 
experimenting with a dual SIM 
variant to enter its phone line for 
the very rst time. He said: “2H18 
iPhone models won’t only o er 
faster LTE transmission speed: We 
predict that at least one of the 2H18 

an intriguing patent led by Apple 
for an electronic device with a 

exible display which can be folded 
in half, hinting that we might be 
seeing a foldable iPhone at some 
point in the future.

Liquidmetal is mentioned as 
a possible material, which would 
make sense since Apple has long had 
exclusive rights to the amorphous 
material in consumer electronics, 
yet so far has done little with it.

The patent also mentions the 
possible use of a micro-LED 
display, which is more energy-
e cient and thinner than OLED, 
and has previously been rumored for 
inclusion on an Apple Watch. With 
Apple only just now moving to OLED 
for the iPhone X, we wouldn’t expect 
another change in technology very 
soon, but if Apple’s strategy is now 
to o er a whole range of di erent 
iPhones — and it seems it is — it 
may be only a matter of time before 
we see a foldable iPhone you can fold 
in half and slip into your wallet.

new iPhone models will support 
dual-SIM dual standby (DSDS). 

“ nlike existing DSDS phones, 
which commonly support LTE+3G 
connections, we believe next-
generation iPhone models will 
support LTE+LTE connections, in a 
bid to enhance the user experience.”

Dual LTE capabilities may, 
however, appear not in the regular 
iPhone  but in a di erent model of 
phone, possibly a cheaper device for 
developing markets. We won’t know 
for sure until the second half of 2018, 
which is when we expect to see 
Apple release its new handsets.

Meanwhile, news of Apple’s latest 
acquisition has led to speculation 
that better low-light photos may be 
on the cards on iPhones. Apple has 
acquired InVisage Technologies, 
which has developed a material that 
can be used in miniature camera 
modules to enable them to capture 
more light. InVisage says its 
QuantumFilm sensor material 
“absorbs the same amount of 
light as silicon in a layer ten times 
thinner.” This might enable future 
iPhones to have much smaller 
camera systems, much better 
low-light performance, or both. 

Elsewhere, specialist Apple-
watcher Patently Apple has spotted 

Patents suggest the 

future is foldable.

Image: United 
States Patent and 
Trademark Office
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>>> David Chartier is a content strategist and writer with vast experience analyzing the tech world.  

He runs the website Finer Things in Tech (finerthings.in) and hosts its podcast, The Finer Things In.

T
HESE DAYS, IT seems like 
the iPhone and iPad have 
stolen much of the spotlight 
from the Mac. Apple Stores 

now often devote the majority of 
space to iOS devices. However, 
while Mac sales haven’t shared 
the meteoric rise of iOS devices, 
they have grown steadily over the 
years, often outpacing all or most 
of the PC market. The Mac is still 
critically important to Apple in a 
number of ways, and I hope Apple 
starts showing it in 2018.

The Mac has had a rocky couple 
years. Yes, sales have grown 
steadily (though slowly), but this 
has been thanks almost entirely to 
MacBooks — and that is arguably 
part of the problem. The Mac mini 
hasn’t been updated in three years. 
While you could argue that the Mac 
mini makes up a niche amount of 
Apple’s small desktop sales, it 
isn’t a good look for the company. 

Worse, the Mac Pro hasn’t been 
updated in four years. It became 
such a large problem that Apple 
held a meeting with a handful of 
tech journalists in 2017 to say, 
basically, “We screwed up, and 
there’s a major redesign coming a 
year from now.” Apple rarely gives 
us notice about products coming a 
week from now, let alone a year.

Mac troubles run deeper, 
though. The signi cantly 
redesigned 2017 MacBook Pro has 

a handful of persistent problems, 
notably a failure-prone keyboard 
requiring an expensive post-
warranty replacement, and the 
unimpressive Touch Bar, criticized 
for replacing the F-key row 
without adding much usefulness.

Then there’s High Sierra. It, too, 
has stumbled, from glaring user-
facing bugs to not-insigni cant 
under-the-hood problems, and 
even a sheer lack of reasons to 
upgrade. “Re-architecting how 
it stores your data” just ain’t a 
selling point for most people. 

After these stumbles, how does 
Apple help the Mac hit its stride in 
2018 and beyond? I think another 
“Snow Leopard” period is in order, 
though I don’t expect Apple to call 
or even acknowledge it as such. If 
you recall, Apple released Snow 
Leopard in August 2009 with 
virtually no major user features. 
Instead, the update was pitched as 
house cleaning to squash bugs and 
modernize the operating system 
foundation for the future. The Mac 
needs that kind of attention, this 

time in software and hardware. 
Apple may have already gotten 
started, too, as a rst-ever “iMac 
Pro” debuts and the promised 
Mac Pro redesign is on the way. 

The MacBook Pro needs help, 
though, especially since MacBooks 
are, by far, Apple’s biggest seller. 
The keyboard needs to fail far less 
often, and the Touch Bar needs 
much more polish and a better 
sales pitch. And while macOS 
may not need a ton of major new 
features (for now), it certainly 
needs a lot of house cleaning.

Apple has shown that it has the 
ability to slow down and focus on 

xes. Here’s hoping the iMac Pro 
and forthcoming Mac Pro are the 
start of a positive new trend.

Looking ahead, DAVID CHARTIER hopes 
for a future where Apple pays some more 
attention to its forgotten hero — the Mac

>THE SHIFT

The MacBook Pro 
needs help, especially 
since MacBooks are 

Apple’s biggest seller

The latest MacBook Pro —  

panned for a failure-prone keyboard.
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Security concerns 
continue to haunt 
High Sierra
Another macOS security blunder... 
BY ALEX SUMMERSBY

we reported in Mac|Life 135 in 
December, the rst was a aw 
in the keychain, which meant 
that malicious code could steal 
the contents of your keychain, 
including critical passwords. 
The second was a bug that a ected 
encrypted APFS volumes (those 
using the new Apple File System, 
introduced in High Sierra and 
now obligatory for SSDs): When it 
prompted you for your password, 
it displayed the password itself, 
in plain text, instead of your 
password hint.

Apple issued updates to address 
all these lapses, but they have left 
a cloud over the company’s 
security testing regime. Apple is 
believed to be aiming to make 
inroads into the corporate market, 
but enterprise users in particular 
will now be more wary of 
deploying High Sierra.

As we went to press, Apple was 
advertising a Security Assessor job 
on LinkedIn. Based in Cupertino, 
CA, the position required “strong 
experience conducting large-scale 
security and risk assessments.” 
It’s not clear whether the previous 
job holder left entirely voluntarily.

APPLE’S LATEST ITERATION of 
macOS, High Sierra, has been 
rocked by yet another security 
lapse. This was the most serious 
yet, potentially giving attackers 
(human or malware) root access 
to any Mac running High Sierra — 
meaning they could do anything 
they wanted.

Apple issued a x, Security 
pdate 2017-001, within a day 

after the fault was publicized to 
the general public on Twitter and 
widely reported in the media, but 
this was some weeks after the 
issue was rst disclosed on its 
developer forums. 

Ironically, the x in turn broke 
le sharing, and Apple rapidly 

issued an additional support note 
(support.apple.com/en-us/
HT208317) with instructions on 
how to get it working again.

The original security lapse was 
a serious vulnerability. Anyone 
could sit at your Mac and gain 
administrator access by logging in 
with the user name “root” and 
leaving the password blank each 
time it was requested. This worked 
when logging in, when making 
changes to system settings, and 
even when accessing the Mac 
remotely using screen sharing.

In nix-based systems, 
including macOS and versions of 
Linux, the root user is the ultimate 
administrator, with unfettered 
privileges. As is usual practice, the 
root account is disabled by default 

in High Sierra, but 
the aw was in the 
function that veri es 
passwords: When 
someone tried to log in 
as “root,” it reset the password to 
whatever that person entered (or 
didn’t enter, if it was left blank), 
and enabled the root account.

According to some reports, this 
took e ect the second time you 
tried to log in — the rst time 
only reset the password and saved 
it — which is some consolation 
because someone just playing 
around wouldn’t have gained 
immediate access. However, it 
later emerged that this aw 
applied to any system account that 
had its login disabled. On the other 
hand, it would not a ect an active 
root account with a password, 
which is likely to be the setup in 
most corporate environments. 

The aw a ected remote access, 
but this is probably o  by default 
anyway, and remote login by SSH 
(using the command line) has 
additional anti-root checks. 
However, screen sharing does 
not, leaving Macs running an 
unpatched version of High Sierra 
vulnerable to attack from outside 
as well as from intruders who 
happen to be sat at your keyboard. 

Apple recommended that 
all High Sierra users apply the 
security update urgently. 

This is the third serious security 
lapse a ecting High Sierra. As 
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I
T’S HARD TO imagine now, 
but three years ago, industry 
analysts were seriously 
wondering if Nintendo had a 

future. The Wii U was a failure, 3DS 
hardware was aging rapidly, and 
many of the pro ts in the games 
industry were moving to iOS. Did 
portable gaming systems like the 
3DS have a future in a world where 
iPhones are so ubiquitous?

2017 was a crucial year for 
Nintendo. Although the Switch 
has been a commercial and 
critical success, its rst game 
on iOS didn’t sell well. Sales of 
Super Mario Run “did not meet 
expectations,” according to 
Nintendo president Tatsumi 
Kimishima. Despite this, 
Nintendo has continued iOS 
game development, with its 
fourth release, Animal Crossing: 
Pocket Camp, hitting the App 
Store in November 2017. 

In many ways, Animal Crossing 
is a better t for iOS than the 
Super Mario universe. Super Mario 
games tend to be about twitch 
re exes and precision, elements 
hard to translate to a touchscreen. 
In contrast, Animal Crossing was 
designed to be slow-paced, a 
game you played for 10 minutes 
and then put away. 

No-one expected the original 
Animal Crossing for GameCube to 

become a cult favorite. In it, you 
arrived on a train and 

found yourself the mayor of a 
town. There was no running and 
jumping, no enemies — and no 
real direction to go. Instead, you 

shed and collected seashells, 
and took your time getting to 
know the animal residents. 

In an era of grim rst-person 
shooters, Animal Crossing dared 
to be di erent. But it was also 
ahead of its time. You weren’t able 
to play through the game in one 
sitting — rather, it was synced to 
the GameCube’s internal clock. To 
“ nish” Animal Crossing, you had 
to spend months returning to the 
game. This is obviously a formula 
better suited for the iPhone than 
your television set. Expectations 
were sky-high for Pocket Camp. 
Could Nintendo’s latest 
experiment meet them?

Pocket Camp has most of 
the elements you expect from an 
Animal Crossing game. You arrive, 
and you’re given your own camp by 

Nintendo’s latest iOS offering, Animal 
Crossing: Pocket Camp, might be simple, 
but it sure is fun, says BRIANNA WU

>GAME LOOP
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The success of Super Mario Run on 

Switch didn’t translate to iOS.

Animal Crossing was a 

runaway hit for Nintendo.



>>> Brianna Wu is the head of development at Giant Spacekat, developer of Revolution 60 on iPhone and iPad,  

and is a regular speaker at industry events, as well as host on the podcasts Isometric and Rocket.

the series’ ever-present assistant, 
Isabelle. Your mission is to invite 
animals to come visit. You’ll go 
from area to area in your RV, 
meeting the residents and 
collecting resources. 

On one level, you comb the 
beach, shing and collecting 
shells. On another, you smash 
rocks with a shovel and collect 
rare ores. This is by-the-numbers 
Animal Crossing gameplay, but it’s 
been simpli ed for a touchscreen, 
making it more fun. Inventory 
management in Animal Crossing 
is usually annoying, but in Pocket 
Camp it’s handled for you. You 
don’t have to equip a shing pole, 
it’s just automatically in your hand 
on a level where you can sh.

Once you have enough 
resources, you are able to craft 
furniture for guests. After you’ve 
done this, the animals will come 
to your camp. It’s very simple 
gameplay, but it’s good fun. 

Ultimately, the personality of 
Animal Crossing is the reason you 
keep playing. It’s charming and 
surreal in all the best ways. I love 
KK Slider, the musician dog. If 
there is a villain in the Animal 
Camp universe, it would be 
Tom Nook, everyone’s favorite 
dishonest raccoon banker.

In some ways, this is the version 
of Animal Crossing that we’ve all 
wanted, with crisp, clean retina 
graphics and vibrant colors. Yet, 
the real problem with Animal 
Crossing is that there’s not 
enough of it. The game can be 
completed in a few days, and 
gameplay is shallow. After you’ve 
invited animals to your camp, 
there’s nothing else to do. This, 
of course, is Nintendo’s point. It 
has been careful to give iOS 
gamers only a taste of its world 

— it isn’t trying to make money 
on these games. It wants you or 
your kids to buy a $200 3DS or a 
$300 Nintendo Switch in order to 
experience the real thing. 

Animal Crossing is free to try, 
but don’t kid yourself — you will 
more than likely end up spending 
money. In-app purchases are the 
worst trend in the history of 
videogaming, but the cynic in 
me suspects that they will make 
Animal Crossing a more successful 
game than the at-priced Super 
Mario Run. It’s depressing that 
not even Nintendo could break the 
curse of microtransactions. 

Nintendo’s e orts to bring 
gaming to iOS have been mostly 
stellar so far. Animal Crossing: 
Pocket Camp doesn’t really live up 
to the high bar set by Super Mario 
Run, but it still proves to be an 
excellent taste of real Nintendo 
magic. Here’s hoping that 
Nintendo’s next iOS release, 
rumored to be a Legend Of Zelda 
game, has more depth.

This is the version of Animal Crossing that 
we’ve all wanted, but there’s not enough of it

maclife.com FEB 2018 17

Animal Crossing boasts clean, 

crisp graphics and vibrant colors.

Rumor is that Nintendo’s next iOS 

release will be a Legend Of Zelda game.
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Work faster and smarter, and boost your Mac’s performance

57 WAYS TO
POWER UP 
YOUR MAC

>>>Feature
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AFTER YOU’VE BEEN using 
your Mac for awhile, you might 
at times start to feel that your 
experience is akin to wading 
through mud. But the thing 

is, although aging hardware can cause 
problems, the way you use your Mac can 
usually make more of  a di erence.

This feature is all about powering up 
your Mac. Not necessarily in a literal 
sense — we’ll talk about upgrading 
your hardware, but the reality is that the 
vast majority of Macs in recent years are 
essentially sealed boxes, and there’s a 
limit to what you can add to boost their 
performance. The days are gone when 
you could crack open a Mac, replace a 
bunch of its internal components, and 
end up with a revitalized, screamingly-
fast computer. Mostly, then, we’re 
looking at everything else — ways in 
which you can “think di erent” about 

how you interact with your Mac, how you 
use apps, and how you set things up.

We’ll  show you how to get the best 
from your input devices, whether you 
prefer a keyboard or a trackpad, and 
how to automate and speed up everyday 
tasks. You’ll learn how to save time and 
make life more convenient by using 
iCloud or other cloud storage options, 
so your stu  is easily accessible on any 
device and wherever you are. And we’ll 
explain how to nd and cull the memory 
hogs and dinosaurs among your apps, 
and optionally replace them with 
lighter, faster alternatives, so your Mac 
starts up faster and performs better.

Follow our advice and, even if you 
don’t go the extra step and make any 
changes to your Mac’s hardware itself, 
it will nonetheless feel like it’s had a 
power boost, as you head towards a 
faster, more productive future.

 maclife.com  FEB 2018   19



EXPLAINED Optimize your mouse, keyboard, or trackpad

A
POWER UP WITH  
BETTERTOUCHTOOL

BetterTouchTool (from $2.99, boastr.net) 

is a single utility designed to enhance all of 

your input devices. Using this app, you can 

define all manner of triggers to perform your 

choice of actions.

B
GET ADVANCED 
TRACKPAD GESTURES

Your Mac’s Magic Mouse or trackpad knows 

more gestures than System Preferences 

provides options for. With BetterTouchTool, 

you can create gestures that use up to five 

fingers or a firm press on a trackpad corner.

C
USE SPOTLIGHT
Sure, you can launch apps on your Mac 

by clicking icons in the Applications folder or 

Dock. But it’s often faster to press Cmd+Space 

to fire up Spotlight, type the first few letters 

of an app’s name, and use the arrow keys and 

Return to open what’s selected.

D
ADJUST YOUR KEYBOARD
System Preferences’ Keyboard pane 

has options for fine-tuning how your keyboard 

works, including defining new keyboard 

shortcuts and creating text replacements, 

so that when you type “omw,” for example, 

it automatically inserts “on my way.”

E
EXPLORE YOUR 
MOUSE OPTIONS

Whatever mouse you’re using, the Mouse 

pane provides settings to adjust how it works. 

Tracking speed will make the most difference 

to your Mac experience — ramp it up to what 

you’re comfortable with.

F
UNDERSTAND 
YOUR TRACKPAD

The Trackpad pane offers three tabs full 

of options. Again, tracking speed is worth 

increasing, but also turn on “Tap to click,” 

so you tap lightly to select items on your 

Mac, instead of having to press.

Optimize your Mac input devices
Whatever you’re using, here’s how to speed up working with your Mac

20 FEB 2018  maclife.com
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TYPE ACCENTED LETTERS
For access to accented letters, hold 
a letter key down to view a menu; 

press 1 to insert the rst character in 
the menu, 2 for the second, and so on. 
Learn shortcuts in Keyboard Viewer 
(System Preferences > Keyboard).

KEYBOARD ACCESS TO
MENU COMMANDS
To access a menu command without 

navigating menus, press Cmd+Shift+/ 
to bring up Help, and start typing the 
command’s name. Use the arrow keys 
to navigate the options, and Return to 
con rm the one you want. This is great 
when you know the name of a command 
but don’t recall its whereabouts.

DUMP YOUR MOUSE
The mouse is a dated input device, 
and poor ergonomically. Consider 

a trackpad so you can use gestures, or a 
pen-based tablet on which the surface 
is mapped to corresponding points on 
your display — then you can jump to a 
position on-screen by lifting the stylus 
and setting it down elsewhere.

USE HOT CORNERS
In the Mission Control pane of 
System Preferences, click Hot 

Corners. In the sheet that appears, 
select what you want to happen when 
you move the pointer into each corner 
of the screen. This can be a super fast 
way to open Mission Control and more.

USE A WINDOW MANAGER
Don’t waste time positioning 
windows precisely — get a window 

manager to do it! BetterTouchTool 
has options for this, but Moom ($10, 
manytricks.com) is better. Have it 
instantly snap a window to a user-
de ned area by using a keyboard 
shortcut or gesture, or by dragging out 
the desired position on your screen.

OPEN APPS FROM 
THE KEYBOARD
BetterTouchTool enables you to 

set keyboard shortcuts to open favorite 
apps or folders. The action to use is 
Open Application/File/AppleScript. 
Shortcuts using Ctrl+Shift plus a 
letter won’t clash with anything else.

HEY, SIRI!

>>> Saying “Hey, 

Siri” works for 

your iPhone and 

iPad. A workaround can add 

it to your Mac, too. In Siri’s 

System Preferences pane, 

select Customize in the 

Keyboard Shortcut pop-up, 

and use Opt+Space. (This 

differs from the similar 

predefined shortcut in the 

pop-up, which requires you 

to hold those keys, not just 

press them.) In the Keyboard 

pane’s Dictation tab, turn on 

Enhanced Dictation.

Go to the Accessibility 

preferences pane, select 

Dictation, and define “Hey” 

as the keyword phrase. Click 

the Dictation Commands 

button, check “Enable 

advanced commands,” 

and click + to create a new 

command. In “When I say,” 

type “Siri,” and set Perform 

to Press Keyboard Shortcut. 

Repeat the keyboard 

shortcut from earlier. Click 

Done. Hey, Siri! is now all set!

> Power up your Mac’s input devices

maclife.com FEB 2018 21

Find a shortcut
Keyboard shortcuts are a great 

way to speed up workflow — it’s easier to 

prod keys than move the pointer. But 

some items don’t have shortcuts, such 

as File > Export as PDF… in TextEdit.

Create a shortcut
In System Preferences > Keyboard 

> Shortcuts > App Shortcuts, click the + at 

the foot of the right-hand pane. Select an 

app, or All Applications if you want the 

shortcut to work everywhere.

Define a shortcut 
Next to Menu Title, type the menu 

command (including ellipses using Opt+;). 

Click Keyboard Shortcut, type your key 

combination (one that doesn’t clash with 

existing shortcuts), and click Add.

HOW TO Define a custom keyboard shortcut

Power up your Mac
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EXPLAINED Automation options

A
UNDERSTAND RULES
The makeup of smart containers varies 

slightly from app to app, but the foundation is 

always rules or conditions (if... then). Figure 

out in plain English what requirements you 

want items to match, and then set about 

defining that using the menu options.

B
START USING
SMART FOLDERS

In Finder, you can create Smart Folders, which 

are automatically filled with items that match 

your specified criteria. The contents could 

be anything from recently-saved JPEGs to all 

items that you’ve tagged with a red label.

C
SMART PLAYLISTS
Smart Playlists in iTunes provide the 

means to create collections of music that 

continually adapt. For example, you might 

create one for recent additions you haven’t 

played at all, or stuff you love (you’ve rated 

five stars, say) yet haven’t played for months.

D
TEXT REPLACEMENT
If you’re always mistyping, use the Text 

tab in System Preferences’ Keyboard pane. 

There, you’ll find a table in which to specify 

text you want to replace with longer phrases, 

plus system-wide settings for shortcuts, such 

as turning quotation marks “curly” (like that).

E
SMART MAILBOXES
By default, the Mail app provides you 

with a sole Smart Mailbox: Today. This contains 

all of the messages that arrived on the current 

day from all of your accounts. But it’s easy to 

create more useful custom Smart Mailboxes to 

automatically group messages that match your 

specified criteria in each case.

F
AUTOMATE TASKS
Automator is used to build workflows 

that can perform tasks on your behalf. In the 

hands of a programmer, it’s a hugely powerful 

facility, but the drag-and-drop system is 

suitable even for complete beginners.

Automate Mac workflow
Use automation to speed up routine tasks and do the boring stuff for you
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Set things up
You can select text and then 

Ctrl-click to run a Google search on it, 

but let’s make a service that uses 

DuckDuckGo. Create a new Service, and 

drag Run AppleScript to the right pane. 

A basic script structure will be added. 

Create a workflow
On the return input line, replace 

input with: "https://duckduckgo.com/ 

?q=" & (input as string). This sends the 

text to DuckDuckGo. Add Display 

Webpages beneath the Run AppleScript 

action. This opens the result in Safari.

Save and use
Save the service as “Search with 

DuckDuckGo.” It can now be selected 

from the Services menu when text is 

selected in an app. In System Preferences 

> Keyboard > Shortcuts, create a shortcut 

for instant access to the service.

HOW TO Create a search service in Automator

CREATE MULTI-LINE 
TEXT REPLACEMENTS
In the Text tab of System 

Preferences’ Keyboard pane, you can set 
short phrases to be replaced with longer 
blocks of text. This is great for accessing 
extended characters, and you can also 
paste multi-line text you’ve written 
in TextEdit into the With column.

AUTOMATE QUITTING
EVERY APP
If you often have many apps open, 

you can close them all using the Quit All 
Applications action in Automator. Set 
whether apps ask to save changes; you 
can also remove speci c apps from the 
action, so they remain open.

SCALE IMAGES 
WITH AUTOMATOR
Automator can resize images with 

the Scale Images action. Set the number 
of pixels for each image’s long side. The 
app will o er to add a Copy Finder 
action so as to retain the originals, 
rather than replace them.

MAKE AN “UNREAD” MAILBOX
On iOS, Apple provides an Unread 
folder for unread emails. Create a 

Smart Mailbox on your Mac to do the 
same. Simply add a “Message is 
unread” condition. Optionally, add 
a “Message is not in mailbox unk” 
condition to omit junk mail.

MAKE A “PAST DUE” 
SMART MAILBOX
It’s easy for emails to get lost 

among the items in your inbox. Create 
a Smart Mailbox with the conditions 
“Message is in Mailbox Inbox” and 
“Date received is not in the last 7 days.” 
This will contain mails that arrived over 
a week ago and need to be dealt with.

ROTATE iTUNES TRACKS 
In iTunes, create a Smart Playlist 
with the rule “Last Played not in 

the last 30 days.” Add a “Media Kind is 
Music” rule. The playlist will include 
tracks you haven’t heard during the past 
month. You can re ne this as necessary 
with ratings and artist information.

AUTOMATE 
HOUSEKEEPING

>>> For anyone 

who downloads 

and works with 

a lot of files, Mac 

housekeeping can feel like 

endless tedium. Hazel ($32, 

noodlesoft.com) is designed 

to toil on your behalf. Setting 

it up involves identifying 

specific folders, then creating 

rules to process files in those 

folders based on conditions 

that files must match.

Hazel works in a similar 

manner to Smart Folders. 

So you can, for instance, 

have Hazel examine your 

Downloads folder and send 

any music it finds to iTunes, 

PDFs to ~/Documents/PDFs, 

and images to Photos. With 

a system like this, anything 

still lurking in Downloads 

can then be safely trashed, 

and Hazel will even empty 

the Trash on a regular basis, 

saving you the hassle 

of doing so yourself.

> Automate more stuff on your Mac

Power up your Mac
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EXPLAINED Store and sync in the cloud

A
USE iCLOUD
When you fully utilize iCloud, your data 

is instantly available on any of your Macs or 

devices — no more half-finished files scattered 

across multiple computers. This can be a huge 

time-saver and help you work more efficiently.

B
SHARE FOLDERS
In iCloud Drive’s options, you can choose 

to store your entire Desktop and Documents 

folders online. Files in these folders then sync 

across Macs signed into your Apple ID, and are 

available on iOS devices too.

C
SYNC SAFARI ON DEVICES
When using iCloud across your devices, 

you can view a list of Safari tabs from any 

device. Bookmarks and your browsing history 

sync, too. Turn on iCloud Keychain to sync 

logins and payment details.

D
OPTIMIZE PHOTOS
If you’re a keen photographer, consider 

storing all your photos and videos in iCloud. 

Then, even your edits become available on all 

your devices — and your Mac will download 

originals only when there’s space to do so.

E
USE GOOGLE DRIVE
Google Drive gives you 15GB of online 

storage for free. With Google’s Backup and 

Sync app, you can integrate Google Drive into 

Finder to access your Google Docs, and also 

sync specific folders for online backup.

F
CHECK OUT DROPBOX
Dropbox offers only 2GB for free, but 

has very widespread support in apps across all 

platforms. You can selectively sync, too, which 

makes it suitable for use as an online-only 

locker for files you’re currently working on.

Live in the iCloud
Save time and trouble by embracing the cloud and syncing all your stuff
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> Optimize your Mac by using the cloud

OPTIMIZE MAC 
STORAGE
With SSDs, new Macs no 

longer always have way more 
storage than their precursors, 
which can be a problem if you 
have a lot of media. iCloud 
Drive provides a solution: 
in System Preferences > 
iCloud, click iCloud Drive’s 
Options button and enable 
Optimize Mac Storage. Older 
documents are o oaded to 
iCloud when space is needed.

GO ONLINE FOR YOUR 
OFFICE TASKS
Apple now o ers online 

versions of its o ce-oriented 
apps like Pages and Numbers, 
but Google’s online suite 
remains the industry leader. 
Consider using Docs (word 
processing) and Sheets  
(spreadsheets) if you want 
fast access to your work 
on any platform, and easily 
collaborate live with your 
friends and colleagues.

SHARE SCREENSHOTS 
WITH DROPBOX
Need a better way to 

share your screenshots? 
Take a look in Dropbox’s 
Import preferences and 

check “Share screenshots 
using Dropbox.” Grabs taken 
on your Mac in the usual way 
will instantly be moved to your 
Dropbox folder, and you can 
then share links to them 
with other people.

BE WARY OF 
OPERATING SYSTEM 
DIFFERENCES

When using Apple’s cloud 
services, be mindful that 
certain features may require a 
speci c system. For example, 
pinning and tables in Notes 
are part of iOS 11 and High 
Sierra. Pinning doesn’t happen 
in earlier systems, and tables 
aren’t shown at all.

EASY ACCESS ON 
YOUR iOS DEVICES
If you’re using iCloud 

Drive and storing your Desktop 
and Documents folders there, 
a major advantage in terms 
of speeding up your work ow 
is the ability to access these 
folders on your iOS devices. 
Open the iOS Files app, 
and you’ll nd those folders 
in the top level of iCloud Drive. 
It’s worth noting that iOS 
devices download les only 
on demand, not by default.

> How to
Create a simple to-do list 
to share with others

Create a list
Use your Mac to create lists you 

can access on your devices and share 

with other people. Open Reminders and 

click Add List. Name your new list — “To-

do list” or similar — and drag it where 

you want it in the left-hand pane.

Share your list
When you position the pointer 

over your list, a button appears to the 

right. Click it to open a pop-up menu. In 

the Share With field, type the email of a 

person you’d like to share the list with. 

(They must have an iCloud account.)

Use your list
Both parties can now use the list, 

which will be updated and synchronized 

across all of their devices. To stop 

sharing a list with someone, select their 

name in the pop-up menu and press 

Delete. You cannot undo this action.

STREAM ALL YOUR MUSIC

>>> So you’re the type of person who enjoys having great sounds 

pumped into your ears at all times. But large music collections 

take up space on your Mac, and are not particularly portable — 

at least not without the hassle of synchronizing tracks, which then eat 

into the relatively limited storage on iPhones and iPads.

If you’re going all-in with the cloud to revitalize your Mac experience, 

consider a music-streaming service. Apple Music will integrate with an 

existing collection in iTunes, and works across macOS, iOS, watchOS, tvOS, 

iTunes for Windows, and even Android, but other services are pretty great 

too, including those from Spotify, Amazon, and Google.

Power up your Mac
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EXPLAINED Get to know your application station

Tame your apps
Keep an eye on your apps, find the memory hogs, and look at alternatives

A
CHECK YOUR APPS
Open the Applications folder to see 

everything you’ve installed. Also, take a look 

at the Applications folder within your user 

folder, if it exists, in case you’ve installed any 

apps to your user account for your use only.

B
VIEW BY DATE USED
You might have a number of apps 

installed that you never use. In Finder’s List 

view, Ctrl-click on a column header, enable the 

Date Last Opened column, and re-sort the list 

by clicking it. Consider trashing any apps you 

haven’t used for a while and no longer need.

C
VIEW BY SIZE
When viewing your Applications folder, 

choose View > as List. Sort your apps by 

clicking column headers; click Size to see 

which take up lots of space. Consider deleting 

unneeded apps if your storage is running low.

D
PRUNE LOGIN ITEMS
In the Users & Groups pane of System 

Preferences, select your account and click 

Login Items. If there’s anything listed here 

that you don’t need, or at least don’t want 

every time you log in, select it and remove 

it from the list to speed up startup.

E
MONITOR APP LOADS
If your Mac often feels sluggish or locks 

up, open Activity Monitor and keep an eye on 

the CPU and Memory tabs. If you find specific 

apps are putting too much load on your Mac, 

start considering alternatives to use instead.

F
REVIEW AND MANAGE 
APPS’ SUPPORT FILES

Some apps install many gigabytes of support 

files, such as GarageBand and its loops. Use 

GrandPerspective (Free, grandperspectiv.
sourceforge.net) to locate large blocks of 

files that you may never need.

A

B C

E

D

F
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Check CPU usage
Open Activity Monitor (it’s in the 

Utilities folder), and click the CPU tab. 

Click the % CPU header, and choose 

View > My Processes. Your account’s 

processes will be listed by CPU usage. 

Note down any that overload your Mac.

View memory usage
Use the Memory tab in a similar 

fashion. Click the Memory header to list 

processes by memory usage. Sometimes 

you’ll find individual Safari tabs cause 

memory pressure problems. Quitting 

and restarting the browser can fix this.

Quit unruly apps
Unresponsive apps are displayed 

in red, and you might need to force them 

to quit. You can kill any process from 

Activity Monitor by selecting it, clicking 

the close button (the x at top left), and 

choosing Quit or, if necessary, Force Quit.

> Tips for being app-happy

USE APPROPRIATE 
APPS FOR THE TASK
Suitability is an important 

consideration when it comes 
to app usage. Think carefully 
about what you’re trying to 
achieve, then the best way to 
get there. For example, don’t 
just type everything in Pages 
– use Reminders for lists, 
Numbers for tabular data, and 
Notes for gathering research.

LEARN ABOUT 
PROCESSES TO  
FIX ISSUES

If you’re not sure what a 
process does, use Google or 
similar to nd out. Sometimes, 
quitting processes rather than 
apps in Activity Monitor can 

x issues, such as killing 
Photos Agent to get a stalled 
Photo Stream working again.

CONSIDER APPLE’S 
DEFAULT APPS
Some Mac users merrily 

install tons of apps. Every time 
something new appears, it’s 
instantly downloaded. But it 
pays to look at what Apple 
o ers. Many of the company’s 
apps are powerful, free, and 
work well with iCloud.

FIND MORE EFFICIENT 
ALTERNATIVES
If you use only a fraction 

of an app’s capabilities, you 
might opt for a lighter, faster 
alternative. Care only about 
words, not page layout? 
Consider iA Writer over Word 
or Pages. Doing only basic 
image editing? Photos can 
do that — you don’t need 
Photoshop or A nity Photo.

OFFLOAD INSTALLERS 
TO EXTERNAL 
STORAGE DEVICES

When you download new apps 
outside of the Mac App Store, 
you likely get an installer 
dumped in Downloads. After 
you’ve used them, you don’t 
need them anymore — they 
just take up space, so o oad 
them to external storage.

PRUNE YOUR MENU 
BAR REGULARLY
Some apps place status 

or control icons in the menu 
bar. That area can soon 
become crowded, making 
items designed for quick 
access hard to nd. Disable 
any  you don’t use — look in 
their parent apps’ preferences.

PREP FOR 64-BIT

>>> If you have an iOS device, you may have noticed some apps 

stopped working with iOS 11. That’s because Apple’s newest 

mobile operating system nixed support for 32-bit apps. The Mac 

hasn’t killed off such apps yet, but Apple has announced the process will 

begin in 2018, whereupon all Mac App Store apps will have to be 64-bit.

To find out what 32-bit apps you’re running, start by going to the Apple 

menu and choosing About This Mac. Click System Report to open System 

Information. In that app, select Applications (under Software in the left 

pane). Finally, click the 64-bit column header to separate 32-bit and 64-bit 

apps. Don’t trash 32-bit apps yet, but keep an eye out for updates, or 

64-bit alternatives if the app hasn’t been updated in a number of years.

> How to
Use Activity Monitor 
to optimize your Mac

Power up your Mac
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EXPLAINED Handling your Mac’s hardware

A
FIND OUT ABOUT YOUR MAC
In the Apple menu, choose About 

This Mac. This is the central area for finding 

out more about your Mac hardware, including 

details about what model it is, its graphics 

processor, connected displays, and installed 

memory and storage.

B
VIEW STORAGE
Click the Storage tab to get an overview 

of all connected disks and drives. The space 

being used is broken down into categories, so 

you can check out whether your Mac’s drives 

are clogged up with photos, apps, or other 

types of data.

C
NOTE DOWN YOUR MAC’S 
MODEL NUMBER

When you want to find out about upgrading 

a Mac, you’ll need to know its specific model 

type. This is displayed in the Overview tab of 

About My Mac, which details the Mac’s release 

year and other specs such as display size.

D
CHECK OUT THE 
FINE DETAILS

Under Overview, click System Report. This 

opens the System Information utility, which 

gives you a more detailed look at what’s 

inside your Mac. Select any category from 

the sidebar to learn more about it.

E
PRINT A REPORT
Should you need to provide some of 

your Mac’s details to a store or repair center, 

use File > Print to make a copy of the selected 

category’s details. As always in macOS, you 

can save from the Print dialog to a PDF in 

order to produce a digital copy.

F
VIEW STORAGE 
RECOMMENDATIONS

Choose Window > Storage Management to open 

a list of recommendations. Here, you’ll see if 

you have options to offload data to the cloud 

(or just delete it), which may have a positive 

impact on your storage upgrade needs.

Upgrade your Mac’s hardware
Revitalize your Mac by treating it to some hardware enhancements

>>>Feature
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Install Duet Display
If you have an iPad doing nothing 

when you’re using your Mac, turn it into 

a second display. Go to duetdisplay.com 

and click Download Mac. Find the file in 

your Downloads, and go through the 

steps to install the helper tool.

Start Duet Display
In the Security & Privacy pane of 

System Preferences, select Privacy and 

then Accessibility. Unlock the pane using 

an admin password, and check Duet. Now, 

restart your Mac, and you’ll then find 

Duet in the menu bar.

Connect your iPad
Install Duet Display ($14.99, App 

Store) on your iPad, open the app, and 

then connect your iPad to your Mac with 

a Lightning cable. Use Duet’s settings to 

adjust resolution and quality. You can 

also enable a virtual Touch Bar.

HOW TO Turn your iPad into a second display

UPGRADE YOUR MAC’S RAM
Most modern Macs are sealed, but 
27-inch iMacs still have upgradable 

memory, as do many older models. Go 
to the Apple menu and choose About 
This Mac > Overview to nd out what 
your Mac model is. The Memory tab 
details memory, and provides a button 
to Apple’s upgrade instructions.

SPEED THINGS UP VIA AN SSD
If your Mac has a hard drive, 
consider upgrading to an SSD. 

Information will be accessed more 
rapidly, and everything will be speeded 
up. You may be able to upgrade older 
Macs yourself; if not con dent, nd an 
Apple repair expert.

TRASH REDUNDANT FILES
Even if you don’t swap out your 
Mac’s internal drive, there are 

ways to improve its performance. For 
example, use GrandPerspective to 
search for redundant les, and trash 
them. This alone can speed up a Mac if 
its startup disk is getting full.

USE EXTERNAL DRIVES
Not keen on trashing a bunch of 

les, even if you no longer actively 
use them? Then o oad them to an 
external hard drive, or even a USB 
memory stick. If the documents are of 
some importance, make sure you have 
at least two reliable backups of them.

IMPROVE YOUR WI-FI
If your main Mac problem is 
internet connectivity being 

sluggish, consider three things: upgrade 
to ber broadband if it’s available; 
obtain better hardware (free routers 
supplied by your service provider are 
often relatively poor), and look at Wi-Fi 
extenders for buildings where the 
signal can’t get through heavy walls.

GET A USB HUB
Simple, cheap time-savers can 
often make a big di erence. If you 

have an iMac and are sick of having to 
disconnect and plug in USB devices all 
the time, grab a USB hub. Boom! Instant 
access to a ton of ports.

IMPROVE 
ERGONOMICS

>>> Increasingly, people 

use MacBooks rather than 

desktop computers. They’re 

great for portability, but not 

for your back, given that you 

typically type while hunched 

over them. Poor ergonomics 

shouldn’t be ignored — back 

complaints are a major 

problem for computer users.

If you have the space and 

funds, look at getting an 

external display, and connect 

a wireless Apple keyboard 

and trackpad to your 

MacBook. You’ll have more 

screen space to work with, 

and a more natural setup  

for typing and interacting 

with your Mac. Your Mac 

hardware won’t necessarily 

feel like new as a result of 

such changes, but you and 

your back might!

> Power up your Mac with new hardware

Power up your Mac
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HEN STEVE JOBS unveiled the iPad nearly eight 
years ago, he made the point that it wasn’t just 
a bigger iPhone or a smaller MacBook — it was 
a third kind of device that, for some tasks at 
least, would be better than either. Since then, 

it’s gotten better than even he may have envisaged. But has 
it grown so capable as to take over tasks that used to be the 
bread-and-butter of those older devices?

Well, okay, the trend may be for ever-bigger phones and 
“phablets,” but the magni cent iPhone probably still has 
its own space. The Mac, on the other hand, has seen Apple’s 
remarkable A-series mobile processors edge ever closer to 
its territory, and not even the super-slim 12-inch MacBook 
can match a tablet’s portability. So is it time to dump the 
desktop and make an iPad your main machine?

Over the next few pages, we’ll take a tour of some key 
apps and accessories that could help make that a real 
possibility. There’s no doubt that today’s iPads are capable 
of some amazing feats, from running recording studios and 

ying with airline pilots, to assisting in operating theaters. 
But for “going full iPad” to be truly practical, you’ll rst 
need to make sure it can cover all the essentials of everyday 
computing, without leaving you running back to the Mac...

The iPad started out awesome 
and has gone from strength to 
strength. So can it cover all the 
bases and meet all your needs?

GO 
FULL 
iPAD?

Are you 
ready  

to

If you’re convinced that using your fingers is 

not really working, then Apple’s $99 Pencil may 

narrow your choice: it works only with iPad Pro. 

Third-party pressure-sensitive styluses for smaller 

iPads, we find, are less satisfactory.

But there are four iPad models in the range, and 

the 9.7-inch iPad is a bargain. Its A9 processor is not 

far behind the Pro’s A10X in power, and its screen is 

sharp, has good color accuracy, and is brighter. 

If you’re looking to go full iPad, ignore the iPad 

mini — it’s too cramped for work and comes only in 

> Which iPad is 
best for you?

W
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?
an overpriced 128GB model at a cost of $399. By 

contrast, the 128GB 9.7-inch iPad is a good buy at 

$429; at $329 with just 32GB, the base configuration 

would be a false economy for full-time use.

Even the iPad Pro’s default 64GB is a little tight, 

and there’s no way to expand it. At $799, we think 

the 10.5-inch model with 256GB hits the sweet 

spot, with fantastic display quality; add Apple’s 

Smart Keyboard ($159) and it’s still more than 

$300 cheaper than a 12-inch MacBook. Cellular 

connectivity, at a crazy $130 extra, is not essential if 

you have an iPhone — just connect the iPad to your 

Personal Hotspot (calling plan permitting). The 12.9-

inch iPad Pro, however, at $949 for 256GB, is worth 

the extra if you need to get lots of work into view.
The 12.9-inch iPad Pro is the obvious choice to cover a full 

range of tasks, but isn’t the only option available to you.
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ith Apple’s Pages, Numbers and Keynote available for free, 
every iPad has the productivity basics covered. Photos can 
manage your media, and Safari covers web browsing. Mail 
should accommodate all your email accounts, GarageBand 
is on hand for soundtracks, and iBooks displays PDFs.

Unless you’re a die-hard Apple purist who never works with anyone 
except other die-hard Apple purists, however — and if so, we salute 
you — you may need a bit more to complete your do-it-all mobile 
workstation. Although Apple’s apps happily handle Microsoft O ce 
documents, there are limits to the accuracy of their conversions, so 
it makes sense to add Microsoft Word, Excel, and PowerPoint, all 
designed for iPad and free to install, along with Outlook and OneNote.

To keep their full functionality after 30 days you’ll need an O ce 3 5 
subscription, from $79.99 per year from . For 
arcane reasons, iPad Pro users without a subscription can only view 
documents, while those with other iPad models get free basic editing 
for “non-commercial purposes” — see .

Desktop dealbreakers
A few of the desktop apps’ more advanced capabilities aren’t available 
even if you pay, which could be a deal-breaker if you need them 
regularly. For example, Word on iPad includes key features such as 
Track Changes, but lacks endnotes and equation editing; and Excel’s 
Pivot Tables can’t be created or manipulated, although Pivot Tables 
already set up in a document are displayed.

To keep in touch with colleagues, FaceTime is ideal if they’re Apple 
users, and Skype works ne if not; Slack also has an iOS app optimized 
for iPad, and integrates with Google Drive, Dropbox, and so on. If you 
need to do more advanced things with PDFs, Readdle’s PDF Expert 
($9.99, ) is comprehensive.

APPS TO CONSIDER

ANYFONT
$1.99  anyfont-app.com

iOS handles fonts across apps, but 

has no Font Book to manage them. 

AnyFont accepts standard font 

files from a Mac via iTunes, email 

attachments, or Dropbox. It’s a little 

cumbersome to use, but a must for 

serious iPad document creation.

DOCUMENTS 6
Free  readdle.com

iOS 11’s Files app is convenient for 

managing documents, and integrates 

third-party cloud services whose apps 

you’ve installed. But Documents is 

more capable, and can view, play, 

and download files from the web.

PCALC
$9.99 pcalc.com

On iPad, PCalc is a solid alternative to 

Apple’s basic, iPhone-only Calculator 

app, with scientific functions, Reverse 

Polish notation, and more.

iOS 11 tip
>>> With drag-and-drop in 
iOS 11, you can hold a nger 
on an item in many apps and 
drag it to another app. Use 
your other hand if you need 
to switch to another app 
before dropping the item 
in, or ask Siri to open it.

AIRMAIL 
$4.99  airmailapp.com

Apple’s Mail app makes it easy to 

add accounts, and many people find 

it works fine. Others complain that 

searching is glitchy and it lacks 

convenience features. For the latter, 

Airmail is fast and lets you write 

messages in HTML or Markdown, 

as well as assigning incoming mail 

to Memo, To Do, or Done.

WORKFLOW 
Free  workflow.is

This Apple-owned utility enables you 

to build workflows (series of steps). 

You drag and drop actions, which 

then automate one or more apps to 

achieve your goals. A workflow might 

send a preset text, upload your last 

photo to a website, or read you the 

time. The more you use your iPad, 

the more it can help.

YOU’LL  NEED
The essential apps  

W
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Creative thinking
Creative software companies haven’t entirely embraced the iPad as a 
primary platform. Though Photoshop Sketch and Illustrator Draw use 
the touchscreen for freehand graphics, on the whole Adobe’s apps 
assume you’ll take your work back to the Mac. Beyond Adobe, however, 
there are now some very powerful creative apps for iOS. 

While lm and TV editors need top-end Macs, iOS apps like the 
established Pinnacle Studio Pro ($12.99, ) and the 
fast-rising LumaFusion ($29.99, ) have tools precise 
enough for serious work. A nity Photo ($19.99, ) 
provides most of the features of a desktop photo editor.

Musicians, meanwhile, have a more than decent choice. Again, 
there’s no full equivalent of Mac digital audio workstations (DAWs) like 
Apple’s Logic Pro X, but Cubasis 2.2 ($24.99, ) is capable, 
while iPad-only alternatives like Auria Pro ($49.99, ) 
are impressive if you don’t need roundtripping with desktop apps.

OMNIGRAFFLE 3 
$49.99  omnigroup.com

While sipping their Latte Macchiatos, 

power users swear by OmniGroup’s 

tools for organizing and visualizing 

information. This all-purpose 

diagramming app brings the 

precision of the Mac version to the 

touchscreen; a Pro version ($99.99) 

adds even more advanced features, 

including JavaScript automation.

iOS 11 tip
>>> Before iOS 11, you needed 
a third-party app to open 
Zip archives. Now, tap a .zip 
attachment in Mail, tap 
again after it downloads, and 
tap Preview Content. Each 

le inside is shown in turn; 
tap the Share icon to save it 
to Files or open in an app.

PENULTIMATE 
Free  evernote.com

Microsoft OneNote is okay, but many 

people prefer Evernote to organize, 

annotate, and sync their notes. It’s 

free for basic use, but subscriptions 

— from $34.99 per year — give you 

more cloud space and formats and 

syncing to more than two devices. 

Add the Penultimate app to handwrite 

searchable notes on the screen.

As long as iOS is reasonably 

up-to-date, your iPad can run 

business-standard apps like Excel, 

as well as advanced creative apps 

such as LumaFusion.

Apple’s Keynote is ideal for creating and delivering 

presentations, but Microsoft PowerPoint is also available.
Yoink 
$4.99  eternalstorms.at

Drag-and-drop in iOS 11 enables you 

to drag things from one app and drop 

them into another right away. Yoink 

is a holding area for multiple items, 

accessible via Slide Over or Split View 

modes, or as a share sheet extension 

or custom keyboard.

Dropbox
Free  dropbox.com

iCloud is a practical place to keep 

documents, but Dropbox is more 

versatile and enables you to share 

whole folders with people in an 

instant. With its app installed, 

Dropbox integrates with iOS 11’s 

Files app as well as share sheets.

Dashlane
Free  dashlane.com

Your keychain on the Mac can store 

more than just login details, but iOS 

lacks the Keychain Access app to 

handle this extra stuff. Dashlane is a 

flexible password, autofill, and private 

info manager. It’s free for iPad-only 

use, and syncing between devices 

costs $39.99 a year; three-year or 

five-year plans are also available.

Go full iPad!
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iOS 11 tip
>>> The iPad has a built-in 
dictionary with de nitions, 
examples and thesaurus 
from both US and British 
sources. Select any word, 
tap it and choose Look Up. 
To add more dictionaries, 
go to Settings > General 
> Dictionaries, where a range 
of languages is available.

Twelve South Compass 2
$39.95  apple.com

The Smart Keyboard and other folding cov
your iPad at a better angle for typing, but i ’
bought a case that doesn’t prop up, use th
portable, folding stand to lift your tablet to
59 degrees in either portrait or landscape m

iRode i-XLR
$149  rode.com 

For professional podcasting 
or audio recording, forget 
the cheap mics sold as iOS 
accessories and invest in this 
XLR adapter plus a quality 
mic suited to your task. You’ll 
de nitely hear the di erence.

vers hold
if you’ve 
is 
o 20 or
modes.

Brydge
$129.99  brydgekeyboards.com

Apple o ers no keyboard for the new 9.7-inch iPad. This aluminum 
model has a sti  hinge, feeling more laptop-like, and also comes in 
iPad Pro sizes. You have to charge it separately, though.

YOU’LL  WANT
The accessories  

>>>Feature
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Shuliancable Flat HDMI Cable 16ft
$7.99  amazon.com

The best way to present from iPad is wirelessly via 
Apple TV, but where that’s not available you’ll need 
your Digital AV Adapter and a long, tangle-free 
HDMI cable like this one, with slim plugs to t 
all sockets. Also available in 10ft and 30ft.

Adonit Pixel
$74.99  adonit.net

Probably the best stylus for non-Pro 
iPads, using the same tech as Adobe’s 
pricier Ink, this doesn’t feel quite as 
responsive as Apple Pencil does on the 
Pro’s special screen, but it works well. 

Logitech K780
$79.99  logitech.com

This Bluetooth unit beats 
keyboard cases for regular 
typing, and will t most  
courier-type bags. A ledge 
holds your iPad, or you 
can prop it up separately 
at a comfortable distance.

Apple Lightning Digital AV Adapter
$49  apple.com

Providing an HDMI output and a Lightning 
pass-through for simultaneous charging, this 
connects your iPad (or iPhone) to almost any 
modern TV or projector for presentations or 
watching videos in up to 1080p HD. You’ll need to 
purchase an HDMI cable separately (see above).

Apple Lightning to USB
Camera Adapter
$29  apple.com

This adapter converts your iPad’s Lightning port to 
USB Type A. Ostensibly this is to import images — 
it doesn’t support other le types — but is equally 
useful to connect a MIDI-to-USB adapter for music. 
There’s a $39 USB 3 version for newer iPads.

Go full iPad!
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Get both the Print & 
 Digital editions for only

 $42
Every Year

Get the print edition of Mac|Life
delivered direct to your door, plus 
instant access on your iPad, 
iPhone, or Android device.

“Mac|Life is the essential 
magazine for Apple lovers, 
as beautiful as an Apple 
product, and packed with 
informative features, 
reviews, and tutorials.”

ALAN STONEBRIDGE,  
Editor

GET THE COMPLETE PRINT & DIGITAL BUNDLE

Subscribe online today… 

myfavouritemagazines/submcl
Or call: 844-779-2822 (toll fre )

l
ee)

SAVE 
71%

TERMS AND CONDITIONS Prices and savings quoted are compared to buying full-priced print and digital issues. You will receive  
13 issues a year.  You can write to us or call us to cancel your subscription within 14 days of purchase. Your subscription is for the minimum 
term specified and will expire at the end of the current term. Payment is non-refundable after the 14-day cancellation period unless exceptional 
circumstances apply. Your statutory rights are not affected. Prices correct at time of print and subject to change. Call center opening hours are  
Monday to Friday 8am-7pm, and Saturday 10am-2pm EDT. For full terms and conditions please visit bit.ly/magterms. Offer ends: 02/30/2018
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Tap with two fingers first to 

choose a kind of text file 

before dragging and dropping 

onto the destination app.

It’s easy to filter by specific 

types of Yoink content. Tap on 

Show All and choose the type 

you’d like to view.

Use Settings > Yoink to turn off 

previews, and choose how long 

clippings stay in the trash 

before being removed.

APP TIPS

Get started in Yoink

iPad users round 
the world rejoiced 
when Apple 
announced drag-

and-drop in iOS 11, but as 
with any new feature, there’s 
always room for improvement. 
Sure, we can nally copy 
items between di erent 
apps, but why not go a step 
further by adding the option 
to temporarily save items 
you’ll want to use again?

That’s the premise of Yoink, 
a virtual storage shelf app that 
enhances Apple’s existing iOS 

Yoink
Save and organize items in iOS 11
$4.99 From Eternal Storms, eternalstorms.at

Made for iPhone, iPad  Needs iOS 11.0 or later

drag-and-drop functionality. 
It’s not a clipboard manager in 
the traditional sense — apps 
like Copied are still best suited 
to that task — but you can drag 
images, text clippings, URLs, 
and other les into the app, 
and then preview, rename, or 
organize them into stacks, 
which are the equivalent of 
folders on the desktop.

After debuting on the Mac 
four years ago to rave reviews, 
Yoink for iOS was designed 

rst with iPad in mind, 
particularly in Slide Over or 

Yoink is a virtual 

storage shelf 

where you can 

save items for 

later use.
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YOINK

  Rich content previews

  Organize content into stacks

  No iCloud sync option

  Very basic keyboard

EXCELLENT 

Split View modes alongside 
other drag-and-drop 
compatible apps. But the 
developers also found a way to 
bring as much functionality as 
possible to iPhone, which does 
not support drag-and-drop.

EASY STORAGE

New items can be imported 
from the current clipboard or 
Photos and Files browsers, 
methods that work on the iPad 
as well. There’s also a share 
sheet extension for adding 
content directly from other 
apps, as well as a keyboard 
that allows users to paste 
items from their Yoink library 
wherever text can be entered, 
like Mail or Notes.

A lock button in the lower 
left corner governs what 
happens when items stored 
in Yoink are dragged out of 
the app. Leaving the button 
unlocked moves the le, 

clearing it from the shelf at the 
same time; locked mode copies 
the item instead, preserving 
the original for later use. This 
gives users the option to use 
the app as temporary or 
permanent storage.

Everything saved in Yoink 
is also indexed by Spotlight, 
making it easy to search for 
a speci c item even while the 
app is closed. iOS 11 integration 
is about as tight as it can be in 
the circumstances, with one 
exception: There’s no iCloud 
sync, so each device can access 
only its own saved content. 
Given that Yoink can store 
anything from a small snippet 
of text to a large movie le, 
this is an understandable 
limitation, but it would be nice 
to at least have the option.

Not every app plays nice 
with Yoink all the time — 
we had occasional trouble 
importing PDF les that were 

originally from Mail 
attachments. This was a 
particular issue in Readdle’s 
PDF Expert, which is otherwise 
a model of drag-and-drop 
compatibility. Worse, the same 

le vanished into thin air when 
we attempted to add it while 
Yoink was unlocked.

This bug aside, Yoink makes 
an impressive 1.0 debut on iOS, 
and should be considered an 
essential addition to any iPad 
user’s arsenal of apps.

THE BOTTOM LINE. If drag-
and-drop is Batman, Yoink 
makes an excellent Robin. 
J.R. BOOKWALTER

Yoink works 

particularly well 

in Split View.

Preview, rename, 

and organize files 

using Yoink.
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A re-release of a 
game from 2010, 
with few changes 
other than updates 

for modern versions of iOS, 
poses an interesting question: 
Can such a veteran of the 
App Store still entertain the 
audiences of 2017 and beyond?

The answer is a simple yes. 
Max may be getting on a bit, 
but his mid-’00s haircut is 

Max and the Magic Marker
Get drawn into Max’s world
$1.99  From Flashbulb Games ApS, flashbulbgames.com

Made for iPhone, iPad  Needs iOS 9.0 or later

The water jet in this game will 

kill you, so getting past it 

without getting wet is vital.

MAX AND THE MAGIC MARKER

  Short levels made for cell phones

  Graphics look nice and sharp

  Music can get annoying

  Limited ink can frustrate

GOOD 

probably his biggest aw. This 
is a left-to-right platformer 
enlivened by the collection of 
ink for the titular paranormal 
pen. You can use a nger to 
move the marker, drawing in 
extra platforms so Max can 
access otherwise unreachable 
areas. The more ink you have, 
the more you can draw.

Your drawings become a 
part of the world, so you can 
drop a big weight on the head 
of a patrolling bad guy, as 
long as he hasn’t put his 
protective hat on, or create 
a shield or bridge to prevent 
death by getting wet. On-
screen controls are limited to 
left, right, jump, and push, but 
that’s really all you need, and 
the buttons are large enough 
so your thumbs don’t slip o . 

The game is also not afraid 
to abandon its central gimmick 
and indulge in some simple 

platforming — levels that 
begin without any ink in the 
magic marker invite you to 
jump, clamber, and push your 
way toward supplies. Levels are 
scored on the time you take to 
complete them, the amount of 
ink you collect, and how many 
of the secret black ink blobs 
you can nd and reach.

At rst, the game guides 
you with dotted lines, showing 
suggested drawings, but you 
can turn this o  after a few 
levels and enjoy the glorious 
trial and error that comes 
from frantically doodling 
over everything as you try to 
chain together a sequence of 
moves, jumps, and platforms 
to progress. It’s more 
simplistic than something 
like Scribblenauts, where the 
fun comes from just how well 
the developers have predicted 
your solutions to problems 
 — especially because Max’s 
limited ink means the 
solutions are often stairs, or 
swirls, or just straight lines — 
but Max still has plenty to o er 
despite his advancing age. 

THE BOTTOM LINE. Perfect 
for snack-size gaming. We’re 
glad Max is back. IAN EVENDEN

Drawing stairs is a 

common solution 

to a problem.
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You’re bound to have 

encountered the ability 

of iOS’ keyboard to spot a 

missing apostrophe — and to 

insert one even when it doesn’t need to. 

The prospect of a better keyboard whose 

reason for existing is to ensure good 

spelling and grammar is tantalizing.

Grammarly promises a sophisticated 

grammar checker, a contextual spelling 

checker, advanced punctuation 

correction, vocabulary enhancements, 

and a synonym finder. That’s all welcome, 

even if you consider yourself a strong 

writer. But constrain your celebratory 

carousing for a moment.

Subscriptions have become 

an increasingly widespread 

way to pay for software 

and services, but once you 

accumulate more than a few, managing 

them becomes a challenge. Bobby is 

designed to keep tabs on recurring 

payments, even if you already use 

other bill tracking software.

With over 260 services built in, Bobby 

covers most popular brands, with a few 

exceptions — Adobe Creative Cloud, cable 

providers Comcast and Spectrum, and 

cord-cutting favorites DIRECTV NOW and 

Sling TV, for example. Thankfully, though, 

it’s easy to add custom subscriptions, and 

Grammarly Keyboard
Avoid many of you’re most embarrassing mistake
Free  From Grammarly, grammarly.com

For iPhone, iPad  Needs iOS 9.3 or later

Bobby 2
Strive to subscribe
Free (IAPs)  From Yummygum, bobbyapp.co

For iPhone, iPad  Needs iOS 9.0 or later

OKAY 

GREAT 

Grammarly Keyboard isn’t smart enough to 

pick out the glaring error in this text message.

Manage all of your software subscriptions right 

from your iPhone with Bobby 2.

Grammarly’s top row shows suggested 

amendments as you type. Tap one and 

the change is made, or you can later run 

through the tool’s feedback in the hope 

of learning mistakes to avoid in future.

In many cases it does a good job, but 

not always. You can use it in almost any 

app, so you might think it’ll help with 

anything from business reports to school 

work — and it will, but it overlooks some 

basic errors. The “you’re” in “Thanks 

for you’re present” went undetected, for 

example. When we requested a double-

check, we were told our text had been 

“checked for hundreds of types of writing 

issues” and none was found. 

there are unbranded credit card options 

for tracking annual fees.

In addition to a refreshed interface 

with the option to customize subscription 

data, Bobby 2.0 introduces conveniences 

such as iCloud sync between devices, 

passcode and Touch ID support, the 

ability to reorder subscriptions, and 

more flexible payment cycles. Most of 

these require separate in-app purchases 

— including the ability to manage more 

than five subscriptions — or you can 

unlock everything for $2.99.

Since we already track household bills 

from apps like Chronicle, Bobby didn’t 

seem particularly useful at first. But 

Grammarly is attractive and does pick 

up plenty of mistakes but, until tools like 

this can truly infer meaning, use it, and 

other tools like it, with caution.

THE BOTTOM LINE. Although it’s 

often effective, exceptions make us 

reluctant to trust Grammarly’s breezy 

assurances. ALAN STONEBRIDGE

customizable notifications came in handy 

for autopay subscriptions like Hulu and 

Amazon Prime, services we often forget 

to enter until it’s time to reconcile that 

particular credit card statement.

THE BOTTOM LINE. Never forget a 

sub again — but pay to unlock Bobby first 

for the good stuff. J.R. BOOKWALTER
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You can approach Just Press 

Record from two angles. On 

the Apple Watch, it’s the 

memos app Apple never 

bothered to make. You prod a big button 

to kick off audio capture (or jump right to 

recording from the app’s complication), 

and press Stop when you’re done. Recent 

recordings remain on your Apple Watch 

for your perusal, and you can revel in 

the fun of using your wrist in a way that 

would have been the envy of characters 

in sci-fi movies a few decades ago.

On the iPhone, the app’s a mite more 

involved, but not to the degree that it’s 

remotely complicated. Apple Watch 

Anyone who uses iPad as 

an alternative to a laptop 

knows that file management 

is more cumbersome than 

it should be, even with the Files app in 

iOS 11. While many apps can natively 

extract files from ZIP archives, the ability 

to create compressed archives is rare.

Kpressor is an app for iPhone and 

iPad that does just two things: open ZIP 

archives so you can extract files for use 

on iPhone or iPad, as well as create 

archives in the first place. It’s the latter 

that will most intrigue power users, 

especially those who frequently send 

large files from their mobile devices.

Just Press Record
Record, sync, transcribe, repeat
$4.99  From Open Planet Software, openplanetsoftware.com

Made for iPhone, iPad, Apple Watch  Needs iOS 11.0 or later

Kpressor
Unzip your file potential
$4.99  From Flying Code Ltd, flyingcode.co.uk

Made for iPhone, iPad  Needs iOS 11.0 or later

EXCELLENT 

GOOD 

Just Press Record... So minimal, you feel that 

even Jony Ive would be impressed.

Adding files to a new or existing ZIP archive 

is a snap with Kpressor.

recordings are squirted across via iCloud 

and then live in the Watch tab, but you 

can also record using your iPhone, by 

way of its own microphone or external 

kit. If you want pro-level recording, you 

can even ramp up the capture quality 

from AAC to 96kHz/24-bit.

Individual recordings can be renamed, 

shared, and played back at various 

speeds. You’ll also notice when firing up 

a recording that Just Press Record will 

have transcribed everything (assuming 

permissions were granted at the 

appropriate time). This means recordings 

are searchable by date and file name, and 

also by content. Sure, the transcriptions 

There are only two buttons  — 

Create ZIP Archive and Open ZIP Archive 

—  but Kpressor also plays nice with the 

Files app, so you can open from or save 

to other compatible apps, including cloud 

storage providers. Selecting any file in an 

open archive displays a preview as well.

Kpressor can also be summoned from 

the Share sheet of other apps, which is 

the most convenient way to use it. On the 

iPad, the app supports drag-and-drop in 

tandem with Slide Over and Split View.

It’s not perfect — we had problems 

saving archives to Apollo Cloud or to 

internal device storage, and the app 

strictly works with the ZIP file format and 

aren’t always accurate, but we’d prefer to 

start with a pretty good first attempt we 

can later tidy up on the Mac, rather than 

have to laboriously type out every word 

ourselves. In short, it’s all very useful. 

THE BOTTOM LINE. Quick and 

convenient audio capture, whatever 

your device. CRAIG GRANNELL

none of its variants. Working with cloud 

storage requires some patience as files 

are sent back and forth. This is a niche 

app, but does a decent job of filling a 

void in Apple’s own file management.

THE BOTTOM LINE. ZIP archives are 

no longer second-class citizens on iOS. 

J.R. BOOKWALTER

>>>App Life
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Every now and again you 

come across a puzzle that 

bumps right up against the 

maximum your brain can 

manage. Follow.trail, while being initially 

confusing because of its lack of a tutorial 

or any on-screen words, slowly reveals 

itself to be something much, much more.

You play a domino, basically. There are 

tiles before you with different numbers 

of dots and, later on, tiles with special 

symbols on them that mean different 

things. You have to navigate through this 

maze of symbols by moving one tile at a 

time to reduce each tile to zero, and then 

go to the finish tile. Sound easy? It’s not.

Although best known for 

rigid (but genius) puzzler 

Euclidean Lands, developer 

kunabi brother returns to 

the organic, playful feel found in its 

debut, Blek, with its new app. But instead 

of coaxing living calligraphy through a 

series of mazes, Frost is akin to a Petri 

dish of tiny interactive universes.

The aim is to guide swarms of tiny 

neon creatures to an orb, which gradually 

fills. Once it’s sated, you move on to the 

next challenge. At first, you’re carving 

paths through space, which the little 

critters flit along. But Frost constantly 

shakes up how everything works.

follow.trail
Prepare to torture your brain
$2.99  From Grzegorz Pykacz, followthetrail.info

Made for iPhone, iPad  Needs iOS 9.0 or later

Frost
Dreamlike interactive universe
$4.99  From kunabi brother GmbH, frost-game.com

Made for iPhone, iPad  Needs iOS 9.0 or later

EXCELLENT 

EXCELLENT 

The levels with black and white tiles will make 

your brain melt into a puddle.

Frost emphasizes play and experimentation 

— you must discover how everything works.

The reason there is no tutorial is 

simply that follow.trail wants you to 

discover the rules through trial and 

error, and it provides an Undo and 

Restart button in order to encourage 

experimentation. It’s frustrating to begin 

with, but becomes more enjoyable as you 

learn the language of the game — what 

each symbol means, what it does, and 

how to get to the finish tile each time. 

It gets especially difficult when you 

find the tile that turns all white tiles 

black, because you can create black 

tiles by stepping onto empty space. The 

solution to each level doesn’t even exist 

at the beginning.

The game regularly introduces new 

creatures and barriers. Some swarms 

are repelled by your pathways. Certain 

scenes resemble complex abstract art, 

with living neon strips that explode into 

jerking electric streamers when bisected 

by a cunningly diverted ribbon of color. 

Others demand you fill multiple orbs — 

which you soon realize rapidly drain 

when creatures stop arriving.

The common factor throughout is a 

sense of play. Frost intentionally tells you 

nothing — you must experiment, make 

discoveries, and take advantage of how 

creatures and obstacles interact. It only 

rarely baffles, and hardened gamers 

Follow.trail is certainly not for 

everyone. It’s an exercise in torturing 

your brain. If you’re a spatially- or 

logically-minded person, however, 

you should definitely give it a try.

THE BOTTOM LINE. An impressive, 

minimalist logic game that will twist 

your mind into a pretzel. KATE GRAY

could probably finish in a couple of 

hours. But to do so would miss the point, 

because Frost is a tactile, gorgeous app 

to properly savor, rather than blaze 

through without a second thought.

THE BOTTOM LINE. Short, but very 

sweet, Frost is a dazzling touchscreen 

gaming experience. CRAIG GRANNELL

>>>App Life
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6 great word games 
for your downtime

ROUNDUP

FOUR LETTERS 
Free  Made for iPhone and iPad

You’d have to be in grade school not to 

figure out that E, P, E, and K can spell 

out KEEP. Or PEEK. Either will do. But 

how about under pressure? Four Letters 

gives you its titular quartet of characters 

to reconfigure into a word, over and over 

again. With a timer counting down all the 

while, even the slightest of brain-fades 

or slips of the finger can prove your 

downfall. Surprisingly tense stuff.

FIGHT LIST 
Free  Made for iPhone and iPad

Think you know a lot of makes of car? 

Go on, name them. Fight List pits you 

against a friend, gives you a topic, and 

then allows you 45 seconds to tap out 

a list as speedily as your thumbs and/

or neurons allow. This is the kind of 

competitive one-upmanship you’d 

get into over a few beers at the bar, 

transplanted on to your phone. Low-fi? 

Yes, but fiendishly addictive all the same.

LETTERPAD 
Free  Made for iPhone and iPad

What do you associate with the word 

“bee”? And, more importantly, which of 

those words can you spell out using the 

grid of nine letters you’ve been provided, 

and are your answers the requisite 

length? That’s the gist of Letterpad — 

which can prove tricky when you’ve 

gotten “hive” and “honey,” but “drone” 

stubbornly eludes you. A great little app 

for testing out your creative thinking.

Give your brain and your vocabulary  
a workout with these fun apps

From crosswords and wordsearches 
through to board games, there’s 
something irresistible about a word 
game. Perhaps it’s the feeling that 
you’re giving your brain a workout as 
well as having a good time, or maybe 
it’s the satisfaction you get when you  

achieve your highest score, think of 
a great word, or beat a rival (or better 
still, the computer). Not sure where 
to start? We’ve rounded up the best 
current iOS o erings, so you can take 
a break while still feeling smug about 
your vocabulary. EMMA DAVIES
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LETTERPRESS 
Free  Made for iPhone and iPad

Imagine a hybrid of Boggle and chess. 

That’s Letterpress! You’re aiming for 

control of the board, and using a tile 

in your word takes it. Play a tile your 

opponent has claimed? It’s yours now. 

Want to give it extra protection? Take its 

surroundings. What results is seriously 

tactical play, in which the pleasure comes 

less from spotting clever spellings and 

more from outfoxing your foe.

SCRABBLE 
Free / $7.99 (premium edition)  

Made for iPhone and iPad

This iOS edition takes the “if it’s not 

broken” approach, focusing instead on 

offering a variety of methods of play. 

Whether you want to fight it out against 

randomly matched online opponents, 

improve by picking up hints against the 

computer, or throw a dictionary across 

the room in local “pass and play” mode, 

this is a solid version of the classic game.

BONZA 
Free  Made for iPhone and iPad

Combining the tactile joy of a jigsaw 

puzzle with the word-building challenge 

of a crossword, Bonza presents you 

with a set of interlinked words (with 

each bunch based on a particular theme), 

broken up into several pieces. It’s then 

your job to move these around and 

restore some lexical sense. A gentle, 

undeniably satisfying way to wake 

your brain up for the day ahead.
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Ahoy there! If you’ve always 
dreamed of boarding a ship 
and heading into icy waters, 
this app o ers a “seven decks” 
virtual cruise of one such 
vessel engineered to navigate 
those chilly climates. Available 
in 15 di erent languages, Polar 
Explorer Icebreaker is a guided 
audio tour, along with photos 
to help you visualize the details 
you’re listening to.

Whether you’re actually 
standing on the deck of the 
Polar Explorer or curled up 
safe, sound, and warm in your 

Polar Explorer Icebreaker
Set sail from the comfort of home
Free  From Polar Explorer Oy, icebreaker.fi

Made For iPhone, iPad, Apple Watch Needs iOS 9.3 or later

bed at home, the app requires 
no internet connection while 
in use, since you download the 
tour in your desired language 
on your iPhone ahead of time. 
Slap on your headphones, tap 
Play, and sail away through the 
rough, ice-covered waters of 
the Arctic and Antarctic seas.

Although the iPhone app 
provides visual ourishes 
including maps and video 
playback, the Watch app is 
strictly a remote control to 
start, stop, and jump between 
di erent sections of the tour. 
This comes in handy when all 
you want to do is kick back, 
close your eyes, and listen to 
the narrated tour, but photos 
are also displayed for some 
visual eye candy along the way.

A couple of downsides: 
There’s no audio from Apple 
Watch, and you’ll have to 
open the iPhone app to rst 
download and select a language 
from those available — 
English, Spanish, French, 
German, Italian, Portuguese, 
Turkish, Russian, Hebrew, 
Malay, Indonesian, Thai, 
Japanese, Mandarin, and 
Cantonese. And yes, there is 

a real, three-hour tour starting 
at €220 — assuming you can 
get to Swedish Lapland, that is.

THE BOTTOM LINE. The 
Apple Watch app is strictly a 
remote control for the guided 
tour, but still comes in pretty 
handy for kicking back and 
enjoying a cruise — real or 
virtual. J.R. BOOKWALTER

POLAR EXPLORER 
ICEBREAKER

  Photos provide visual reference

  15 languages available

  No audio from Watch

  Basic remote functionality

SOLID 

There are various 

little conveniences 

in watchOS 4 

— one is the new 

All Apps button, 

which is in the 

Dock as a 

shortcut to the 

App Launcher. 

To find it, press 

the side button, 

turn the digital 

crown and scroll 

to the bottom.

WATCH TIP

All Apps from Dock
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Babies and toddlers 

are as fascinated by 

Apple Watch as 

adults, but most 

developers save their 

best kid-oriented 

apps for iPhone and 

iPad. Baby Fidget fills this gap quite 

nicely, with a simple app that’s as fun 

for the little ones as it is easy to use.

Think of it like a portable stack of 

flashcards: Every time a youngster 

taps on the Watch display, the screen 

changes to a different whimsical 

shape, vibrant color, fun letter, or cute 

creature. Everything has been designed 

to attract and keep the attention of 

your child, and one small purchase 

works on every device in the house.

We often complain about the lack of 

sound on many Watch apps, but this is 

a rare exception. Tap the Mute button 

after launching the app, and you’ll hear 

the same pleasant music box, lullaby 

music playing in an endless loop for as 

long as the kid plays with your Watch.

THE BOTTOM LINE. Fun Watch-

based flashcards entertain, and the 

looping lullaby music is a nice touch. 

J.R. BOOKWALTER

There are countless 

astrology apps, but 

few have bothered 

to accommodate 

the Apple Watch. 

Daily Horoscope — 

Astrology! has 

recently arrived to right that wrong.

However, something is amiss from 

the start. Although the iPhone app 

displays proper English by default, the 

Watch app doesn’t have the same knack 

for localization. Using the digital crown 

to scroll through available star signs 

displays the Today button as “Avui” 

— which Google Translate detects as 

the correct word in Catalan. Odd, given 

that the developer is based in Turkey.

We also had frequent connectivity 

issues between Watch and iPhone 

(“carregando” — “charging” in Catalan, 

“loading” in Portuguese), sometimes 

even while changing signs. Worse, the 

app got stuck while loading the day’s 

horoscope, and there’s no option to hop 

between days or see monthly or yearly 

predictions as in the iPhone version.

THE BOTTOM LINE. The horoscope 

says “skip it,” unless you want to learn 

Catalan. J.R. BOOKWALTER

Baby Fidget
Calm your child with images and sounds
$0.99  From Britney Bachmann, babyfidget.com

Made For iPhone, iPad, Apple Watch Needs iOS 9.0 or later

Daily Horoscope — Astrology!
Disappointing, whatever your star sign
Free  From Refik Kasal, bosphorusmobile.com

Made For iPhone, iPad, Apple Watch Needs iOS 8.2 or later

EXCELLENT 

POOR 

t

t

SHARE A PHOTO

While viewing any photo 

on your iPhone, tap the Share 

button and then select Create 

Watch Face. This is a new option 

available in iOS 11.

CHOOSE OPTIONS

Now you can select from 

a few options, such as where 

to display the time or position 

complications. Tap Add to start 

using your new Watch face!

PICK A FACE

Next, you’ll have the option 

of choosing between a Photos or 

Kaleidoscope Watch face; the 

latter is the best choice for 

displaying a single favorite image.

HOW TO

Make your own 
Watch Face
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Adobe Premiere Elements 2018
Improved video editing app perfect for beginners
$99.99  From Adobe, adobe.com

Features Guided mode, new tools  Needs OS X 10.11 or later, 4GB of RAM

A
dobe Premiere Elements 2018 is 

comparable with Apple’s iMovie. Both 

apps are designed to help entry-level 

editors import, fix, and share their clips as 

slickly-edited projects featuring titles and 

transitions. If you’re new to video editing, 

Premiere Elements 2018 is worth a look 

— its Guided mode will take you through 

basics such as importing clips and trimming 

them in the Timeline. Step-by-step text 

instructions are accompanied by highlights 

around appropriate buttons and panels in 

the workspace, so you can quickly get to 

know where key editing features are located 

and how to use them. This gives Premiere 

Elements 2018 an edge over iMovie, which 

lacks an interactive workspace and workflow 

guide for newcomers to editing. The Video 

Story mode helps turn raw footage into a 

short, slick video suitable for sharing via 

social networking sites.  

One thing Premiere Elements 2018 does 

well is provide ways to speed up the editing 

process. Trimming clips to lose the boring 

bits is a common video editing task, so 

the new Smart Trim feature is designed to 

speed up this time-consuming part of your 

workflow. Smart Trim analyzes the footage 

for the presence of faces, groups of people, 

or areas that are in focus, for example. You 

can also manually set it to look for properties 

such as action in a clip, so the footage will 

be trimmed to include only those scenes that 

feature activity. Once Smart Trim has found 

appropriate scenes in a longer clip, you can 

fine-tune them using the Timeline’s trim 

handles. Smart Trim is a springboard to help 

you find the best bits of your footage more 

quickly, although it can be a bit hit and miss 

in its automated results. 

Candid Moments is another new feature 

that can help you quickly harvest social-

media-friendly assets from a video clip. If 

you’ve filmed an event such as a kids’ party, 

then you can run the footage through the 

Candid Moments tool to automatically find 

frames that you can export as stills to share 

on Twitter, for example. These automated 

features help speed up the editing process, 

so editors can get finished videos onto 

social media platforms more quickly. 

Overall, Premiere Elements 2018 can 

help beginners cut their video editing teeth 

with the Guided mode, but as they grow in 

experience, they can expand their developing 

skills in the feature-packed Expert mode. 

Unsure whether this is worth $100 to you? 

Put the app to the test with the free trial 

version, and compare it to iMovie.

THE BOTTOM LINE. Great for 

newbs, with ample power for the 

next step up. GEORGE CAIRNS

ADOBE PREMIERE 
ELEMENTS 2018

  Helps beginners learn

Finds key scenes 
automatically

A little pricey given 
that iMovie is free

Tacky template 
graphics

GOOD 

TOUGH TESTING, TRUSTED RATINGS
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W
ireless noise-canceling headphones feel 

like the pinnacle of private listening 

technology. In this regard, B&W’s PX 

headphones are a massive success.  

The feature-set covers all the bases of 

a modern pair of headphones. Charging by 

USB-C? Check. A standard, non-proprietary 

3.5mm jack? Check. A complete set of 

physical button controls? Check. A 

respectable 22 hours of battery life? 

Check. Bluetooth aptX HD support? Check. 

Even more impressive is the ability of the 

headphones to understand when you’re using 

them and when you’re not, turning off when 

you remove them from your head. You can 

even pause by lifting just one of the earcups. 

Occasionally the technology can misfire. 

There were a couple of moments when we 

paused our music with the headphones still 

on our head, only for it to resume playing 

after a couple of seconds in confusion. But 

these problems were few and far between, 

and it’s possible to change the sensitivity 

of this feature in the PX’s companion app. 

We tried the PX on a subway train 

during rush hour using the default (“Flight”) 

noise cancelation setting, and it performed 

admirably, with a level of cancelation that’s 

up there with the likes of Bose and Sony. 

If you want more control, there are three 

noise-canceling modes to choose from in the 

companion app, each designed to cancel and 

let through certain frequencies. The “City” 

setting is designed to let through traffic 

noise, so you can walk the streets in safety 

while using the headphones. “Office” lets 

through the higher frequencies of the human 

voice, so you can hear colleagues talk to you, 

while “Flight” focuses on eliminating the low 

rumble of a plane. 

We love the functionality and noise 

cancelation of the PX, but its sound quality 

doesn’t quite hit the same heights that we’ve 

come to expect. The biggest problem is the 

mids and trebles, which have a fuzziness to 

them that means complex soundstages can 

end up feeling a little squashed. 

Listen to the likes of Radio Protector by 

65daysofstatic and, when the song really 

gets going, the headphones make the sound 

feel messier and noisier than it should be. 

Overall this leads to a loss of detail. 

At the bassier end, the cans fare a great 

deal better. Play Freeze Me by Death from 

Above 1979, and its driving bass line is 

present in spades. It’s tight, punchy, and 

given the space to hold the song together. 

It feels odd to complain about the PX’s 

sound quality, but it’s a sign of just how 

mainstream noise-cancelation technology 

has become that at this price we’re able to 

expect premium sound quality in addition 

to everything else the headphones offer.

THE BOTTOM LINE. B&W may be late 

to the noise cancelation party, but the wait 

has been worth it. JON PORTER

Bowers & Wilkins PX
An impressive first noise-canceling effort
$399  From Bowers & Wilkins, bowers-wilkins.com

Features Active noise cancelation, smart controls, aptX Bluetooth,  
22-hour battery life, three environment filters

BOWERS & 
WILKINS PX

  Noise cancelation

  Auto-pause/play

  Lacking in definition

  No B&W black leather

GREAT 

Tough testing, trusted ratings
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Lightroom has been popular with pro 
photographers for years. The desktop 
version, now called Lightroom Classic CC, is 
still available, with little changed from the 
previous version (6.5). Alongside it, however, 
is a new, cloud-focused app, which has now 
assumed the name Lightroom CC. Although 
it has many of the core features of the “old” 
Lightroom, it’s been given the “prosumer” 
treatment, with more advanced tools 
removed and more focus on automation.

The biggest change is that Lightroom now 
insists on uploading your originals and edits 
to the cloud, with storage space based on 
your subscription tier. There is an option to 
also store originals locally, but not to ignore 
the cloud. So at best you’re keeping one 
copy locally and one remotely. This is good 
for backup, but those who regularly shoot 
hundreds of gigabytes of raw images are 
going to have to pay to upgrade their storage. 

This change is mostly aimed at letting 
you work across devices, and to this end 
the iOS Lightroom app has been completely 

Adobe Photoshop Lightroom CC
Lightroom moves to the cloud as part of a radical overhaul
From $9.99 per month (Creative Cloud subscription)  From Adobe, adobe.com

Needs OS X 10.11, internet connection

LIGHTROOM CC

Slick and user-friendly 
interface

Share and edit across 
devices seamlessly

More advanced tools 
have been removed

Pro users are going to 
run out of cloud space

GREAT 

overhauled as well, with near 
feature parity with the Mac 
and Windows apps. Uploading 
to the cloud is automatic, so 
all your edits are available on 
every device. All versions now 
have a stripped-back interface 
with editing and correction 
tools sliding in from various 
panels. The tools are still very 
good for cropping, tonal, and 
color adjustments. But while 
they do go beyond the (much 
improved) tools in Apple’s 
Photos app on the Mac, many 
of the more detailed tool 
options are now missing, which 
will trouble professionals. 

For hobbyists and 
home users this is 

less of an issue, and 
you can still achieve remarkable edits and 
improvements to photos, create albums, add 
tags, and share more easily across devices. 
More advanced users, however, will want to 
see more exibility and more ne-grained 
tools return in future updates. 

THE BOTTOM LINE. A great cloud-focused 
app to edit, tag, and share images. Advanced 
users will nd it lacking. HOLLIN JONES

Edits remain live across all 

devices, so you can start 

working on one device 

and finish on another.

You have to use the cloud for storage, though there’s also 

an option to store copies locally in addition to remotely.

>>>Reviews
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There once was a utility called TapDex, which provided 
convenient access to Mac contacts from anywhere. It was 
great for looking up phone numbers or copying addresses, 
but was sadly abandoned in the transition to macOS.

Thankfully the creators of Fantastical have come up 
with Cardhop, a contacts app that goes beyond those 
modest ambitions. Rather than simply display information, 
Cardhop can edit entries, assign groups, add new elds or 
notes — basically anything the macOS Contacts app can do, 
but straight from the menu bar.

For those at a desk all day, Cardhop is a real boon. Using 
con gurable Quick Actions, you can initiate text messages, 
emails, and calls right from cards; outgoing calls are routed 
to Continuity or a Bluetooth-connected iPhone or iPad.

Clicking any contact displays it as a popover, but you can 
type shortcuts to act upon speci c data — “Call Mom” to 
initiate a call upon hitting the Return key, for example. 
Cardhop also makes better use of contacts, placing those 
with a birthday or recent activity at the top for easy access.

THE BOTTOM LINE. This is the contacts app Apple should 
have made all along. J.R. BOOKWALTER

One pretty common complaint about Photoshop 

Elements is that as you advance through its 

guided edits and tools, your ambitions as an editor 

advance too, only to be stymied by its constrained 

set of features. Elements+ claims there are loads 

of features buried within Elements that can be 

freed up with a few lines of code.

Among the benefits is a traditional Curves tool, 

applied as an adjustment layer, a proper Quick 

Mask mode, and a comprehensive selection of 

Smart Object commands — all accessed through 

Elements’ Effects panel. You can create paths 

from selections, text layers, and vector masks, 

addressing a major omission. There is also a 

good set of scripts, including focus stacking.

Navigating the tools takes a little getting used 

to — they don’t sit with Elements’ regular controls 

— but there’s absolutely tons here. Elements+ is 

well worth a look if you object to Creative Cloud 

or simply love Elements too much to leave.

THE BOTTOM LINE. A very worthwhile 

addition to Elements for users who don’t want 

to go to the full Photoshop. DAVE STEVENSON

Cardhop
Keep in touch with this contacts app 
$19.99  From Flexibits Inc, flexibits.com

Needs OS X 10.11 or later

Elements+
Get more from Elements
$12  From Simple Photoshop, elementsplus.net

Needs Photoshop Elements 2018

CARDHOP

  Edit and view contacts

  Custom Quick Actions

  No favorites list option

  No iOS version

EXCELLENT 

ELEMENTS+

  Loads of extra tools

  Adds pro functionality to entry-level software

  Gives Elements a new lease of life

  Bit of a learning curve, with features all in Effects panel

EXCELLENT 

Tough testing, trusted ratings
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L
ogoist 3 is a vector drawing app. No, 

don’t run away! It’s an app that tries 

to make vector drawing work for normal 

people. There’s a Bézier curve tool, but you 

can ignore it and build graphics from ready-

made shapes, styles, and effects.

Templates are provided for logos, business 

cards, and greeting cards. A better place to 

start, though, is the app’s Showcase, which 

presents dozens of finished pieces that you 

can unpick. At the top left of Logoist’s single 

window is a panel showing all the objects and 

groups in the artwork in a tree structure, like 

folders in Finder; clicking on any item in the 

artwork highlights it in the tree, and vice 

versa, with an animated glow so you can’t 

miss it. (The whole interface makes good use 

of animation, but this can be turned off.)

It’s a great way to see how vector drawings 

are constructed, although we’d have liked 

more help in selecting items behind others. 

Effects include glows, transparency, emboss, 

gradients, and “Generators,” textures that 

follow the shape of an object. From scratch, 

it’s easy to click Shape or Clipart in the top 

toolbar, pick from the options, and choose 

from the styles listed on the left. On the 

right, you can customize each effect.

Logoist 3 gets a lot right. It has functions 

like grid snapping (with radial and concentric 

grids), adding and subtracting objects, align/

distribute, and creating instances of an object 

that inherit changes. Features like shadows 

are well handled. Controls are comprehensive, 

yet it all feels more accessible than a pro app 

such as Adobe Illustrator or Affinity Designer.

In the end, though, this is a moving-pretty-

things-around app, not a drawing app. Even 

if you get something looking almost right by 

combining shapes and styles, you can’t edit 

the vector points that make them up to finish 

the job off. You can export your work as EPS, 

PDF, or SVG, and edit the lines in another app, 

but that kinda misses the point.

New files are set to a tiny 500x500 pixels 

without asking, and if you click the Canvas 

button and pick a physical size, such as 

Letter, the app calculates the pixel size at 

72dpi, far too low for print (and who designs 

logos just for screen use?). This won’t matter 

if everything is output as vectors, but some 

effects have to be rendered to bitmap — a 

Check Vector Export option warns you which. 

It’s also odd that style dimensions are set in 

pixels, so they don’t scale correctly within 

the app. And despite the app’s name, the 

few logo templates aren’t very usable. This 

is disappointing, but there’s still a lot here 

for those who want cool artwork fast.

THE BOTTOM LINE. Logoist 3 has an 

impressive range of features that go much 

more than skin-deep. ADAM BANKS

Logoist 3
Stunning vector graphics
$14.99  From Synium, syniumsoftware.com

Needs OS X 10.12 or later

LOGOIST 3

  Excellent interface

Great-looking effects

  Poor logo templates 

Awkward mix of vectors 
and pixels

GREAT 

>>>Reviews
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Many Mac launchers aspire to replace the 
Dock. Station di erentiates itself with a 
multi-level layout. You can simply drop 
apps, folders, and documents into it, but 
Station encourages you to create custom 
containers (it calls them folders, but they’re 
not really) — click one and it opens above, 
so you can drag items into the panel.

Containers can be nested to a dizzying 10 
levels — but that may be overcomplicating 
things. With restraint, Station’s approach 
makes sense. You can create containers to 
house related apps that sit alongside 
containers of shortcuts to relevant projects.

Setup takes time, but Station has some 
smart ideas. Copies of an item can exist in 
multiple places, and you can launch the 
entire contents of a container with a single 
command. However, from an e ciency 
standpoint, there are shortcomings.

Station
Multi-level launching with a mouse
$14.99  From True North Software, truenorthsoftware.com/station

Needs OS X 10.11 or later

STATION

  Flexible sort options

  Folder launching

  Time-consuming setup

  No folder drill-down

OKAY 

There’s no support for hierarchical Mac 
folder navigation: With Apple’s Dock in list 
or grid view, you can blaze through nested 
folders, but Station just opens each container 
in Finder. The app’s also heavily mouse-
centric — there’s no keyboard navigation 
(unlike using Ctrl+F3 to jump to the Dock), 
not even a keystroke shortcut to con rm you 
want to launch a container’s content. And if 
Station’s larger than your screen size, it can’t 
be swiped back and forth with a trackpad 
gesture — you must drag a scroll bar. 

These limitations don’t mean Station’s a 
write-o , but they do suggest it’s for a very 
speci c user — one who wants extremely 
precise shortcut placement, and who is very 
much wedded to a mouse.

THE BOTTOM LINE. Interesting, but 
Station’s smart ideas are o set by too 
many limitations. CRAIG GRANNELL

Station’s panels open one 

above the other. Want to 

give the app a different 

look? You can adjust its 

color and transparency.

>>>Reviews
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There are plenty of smart tracking 
devices on the market to locate lost items 
with the help of your iPhone. However, 
most Bluetooth-connected gadgets make 
the search harder than necessary by only 
emitting audible beeps without the aid 
of any visual reference.

Pixie turns nding misplaced keys 
or other objects into something akin to 
a game of Pokémon Go, complete with 
augmented-reality “pixie dust” that helps 
narrow the hunt to a much smaller area. 
Unlike simple trackers, Pixie requires 
two or more teardrop-shaped smart tags 
known as Pixie Points — the rst attaches 
to your iPhone with the included peel-
and-stick adhesive backing, while the rest 
are placed on objects you want to track.

At $49.99 per pair, Pixie Points are 
about the same size as competing trackers 
(1.9 inches tall and 1.4 inches wide). Even 
at just 0.1 inch thick, they do stick out like 
a sore thumb on the back of your iPhone.

With the arrival of Apple’s ARkit, Pixie 
has reduced the amount of time required 
to nd items, providing additional visual 

ourish to the experience. The rst step is 
to do a quick panoramic scan of the room, 
which takes just a few seconds. A 3D “X” 
appears on-screen to mark the spot where 
an item is located, along with a path of 
“pixie dust” encircling the area. Once 
you walk within ve feet, the iPhone app 
switches to a virtual metal detector view, 
which guides you to the exact spot.

Pixie
Find lost items with the help of AR
Free  From Pixie Technology Inc, getpixie.com

Made for iPhone 5S or later  Needs iOS 9.0 or later (iOS 11 required for ARkit support)

On your iOS 11 devices, Pixie uses ARkit 

to speed up search.

Pixie helps find misplaced items using 

smart tags known as Pixie Points.

PIXIE

Augmented reality 
visual search

App supports up to 
seven items

Pixie doesn’t remember 
scanned rooms

Pixie Points last only 
around 12 months

GREAT 

Support for ARkit de nitely speeds up 
the process by eliminating the real-time 
compass mode users running iOS 10 and 
earlier must endure. The app doesn’t 
remember previously scanned rooms, 
though, so this process must be repeated 
every time, which tends to get a little 
tedious after a few searches.

The novelty of the app does tend 
to wear o  over time, but the biggest 
limitation is that Pixie Points last only 12 
months of average use before the battery 
runs out, and it can’t be replaced. At that 
point, the Points have to be thrown out 
and replaced with new ones. As if to 
compensate for this fatal aw, each pack 
comes with free accessories including a 
keychain adapter, curved surface adapter, 
and extra adhesive pads.

THE BOTTOM LINE. ARkit makes 
locating items faster, but not by much.  
J.R. BOOKWALTER

Tough testing, trusted ratings
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F
ujifilm’s latest X Series mirrorless camera 

replaces the aging X-E2S. Instead of a 

DSLR-style design, with a raised, central 

viewfinder, the X-E3 has a classic rangefinder 

style, like the X-Pro2, but with diminutive 

proportions and streamlined controls.

The spec is not compromised, though. The 

X-E3 features Fujifilm’s 24.3MP X-Trans CMOS 

III APS-C sensor, bettering the 16.3MP sensor 

in the X-E2S. The ISO range increases, with 

a native sensitivity range of ISO200–12,800; 

the expanded range is ISO100–51,200, with 

support for Raw files as well as JPEG, too.

There’s a 2.36-million-dot OLED electronic 

viewfinder with 0.62x magnification, while 

the rear boasts a three-inch touchscreen 

display with a resolution of over one million 

dots. You can tap the display to focus and 

trigger the shutter, and also swipe through 

and pinch-to-zoom to review images.

There’s Wi-Fi and NFC connectivity, and 

also Bluetooth — pair the camera with your 

device and install the free Camera Remote 

app to transfer images to share easily.  

The X-E3 also offers 4K video capture 

at 30p as well as Full HD at 60p, with both 

formats supporting film simulations. There’s 

a 2.5mm jack input for a mic, but not for 

audio monitoring. There’s just one SD card 

slot, and no support for faster UHS-II cards.

The X-E3 has a decent handgrip as big 

as the X-E2S’s, and is comfortable to hold 

one-handed. While not weather-sealed, it has 

a premium feel thanks to magnesium-alloy 

top and bottom plates and machined dials.

With the smaller body, there’s no built in 

flash; instead, there’s a pocket-sized h t h -

mounted flash. The shutter speed dial offers 

settings from 1 to 1/4000 sec plus Bulb, Time, 

and Automatic; the exposure compensation 

dial runs from –3 to +3EV. A new, small rocker 

switch round the shutter speed dial gives the 

option of full Auto mode — ideal for novices. 

The big change, though, is the streamlined 

rear layout. The display extends all the way to 

the left edge, and you can flick right, left, up, 

or down on the touchscreen to access four 

different functions or settings, which can be 

tailored to your preference in the menu. 

The X-E3 uses the same 325-point AF 

system as the X-T20. With five AF-C presets 

to pick from, AF tracking is much improved. 

Focusing could be a bit faster, but it’s a solid 

performer. While the X-E3 isn’t marketed as 

an action camera, it can shoot at a very fast 

14fps using the electronic shutter, or a more 

restrained 8fps with the mechanical shutter. 

Fujifilm’s TTL 256-zone metering system 

performs very well, although when presented 

with a high-contrast scene it can sometimes 

underexpose the shot. Image quality is some 

of the best available from an APS-C-based 

camera, detail is excellent, and the film 

simulation modes are very effective.

At 350 shots per charge, battery life is n t 

bad for a mirrorless camera, though a DSL  

rival like the Nikon D5600 offers 820 shots. 

THE BOTTOM LINE. The X-E3 is a joy to 

shoot with, and is everything you’d want in 

a compact mirrorless camera. PHIL HALL

Fujifilm X-E3
Fujifilm’s smallest X Series camera packs a punch
From $900 (body only)  From Fujifilm, fujifilmusa.com

Features 24.3MP APS-C CMOS III sensor, 3-inch color touchscreen, Bluetooth

FUJIFILM X-E3

Tactile controls and
refined handling

Decent AF system, cool
film simulation modes

Battery life could
be better

Display is fixed and can
not tilt or swivel

EXCELLENT 
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THE X-E3 ALSO HANDLES 
IMAGE NOISE VERY WELL. 

IT ’S  ONLY AT ISO3200 
THAT LUMINANCE NOISE 
BECOMES NOTICEABLE

The Fujifilm X-E3 camera 

with XF23mmF2 R WR 

Lens Kit costs $1,149.95.

Tough testing, trusted ratings
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BBEdit has been around so long, it’s almost 
part of the Mac’s furniture. Version 12 arrives 
25 years after the original, which is some 
achievement. But a bigger achievement is 
that the app remains relevant, powerful, 
and e cient, and almost never frustrates.

Take BBEdit 12’s new themes. The app now 
defaults to black, to be “down with the kids.” 
But if you’re old and gray, you can stick with 
the old and gray theme; when you upgrade 
BBEdit, it won’t touch your existing setup.

But there’s more to BBEdit 12 than a 
re-skin. New features include improvements 
to the FTP view (you can now open/close 
folders), the ability to paste using a text lter 
(which o ers loads of possibilities if the 

lter’s a script), and support for Split View.
The last of these works nicely with the 

newly integrated WebKit inspector. When 
editing Markdown, you can have your .md 
document on the left and a preview on the 
right, with the inspector below. We think 
iA Writer’s own Split View remains superior 
for streamlined writing, but BBEdit’s 

BBEdit 12
This powerful text editor still doesn’t suck
$49.99  From Bare Bones, barebones.com

Needs OS X 10.11 or later

BBEDIT 12

  Hugely powerful

Column editing is great

Canonize is even better

  Not the prettiest app

EXCELLENT 

changes are welcome for serious editing.
Our favorite new features, though, are 
Columns Editing and Canonize. Columns 
Editing is for comma- and tab-delimited 
text les. Within BBEdit, you can copy 
one or more selected columns to a new 
document, or rearrange columns without 
doing a copy-paste dance with a spreadsheet 
app. The appearance is resolutely plain text 
— you get no sorting or styling niceties, but 
then that’s what Numbers and Excel are for.

Canonize is a superb batch search-and-
replace tool for multiple text strings. You 
de ne required changes in a bespoke le, 
which is then applied to other documents. 
For dealing with style guides (for example, 
US to UK English), it’s a huge time-saver. 

The app remains absurdly powerful. We 
opened a 150MB text dump in BBEdit on 
a wheezing Mac mini, which took a short 
while, but a nd-and-replace of 789,097 
changes occurred in a blink of an eye.

BBEdit o ers a great mix of power and 
reliability for a whole range of users, for 
writing, editing, or coding. And it’s a nice 
touch that you save ten bucks even if the 
last time you bought BBEdit was in 1992.

THE BOTTOM LINE. After all these years, 
reliable and powerful BBEdit feels like even 
more of a bargain. CRAIG GRANNELL

BBEdit is now a better 

macOS citizen, notably 

with its excellent support 

for Split View.

Canonize performs multiple find-and-replace operations 

across documents, based on a custom reusable template.

>>>Reviews
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This external SSD is a little larger than others we’ve tested 
recently, so you may be unsurprised to learn that CalDigit 
also sells portable hard drives in this design. The Tu  aims 
to provide robust protection for video shot on location, so 
you can quickly transfer it for safety in the outdoors or carry 
it back to base. It comes with a sturdy case, the catch on 
which clasps rmly shut and has a compartment for the 
USB cable to keep everything together.

There are smaller water-resistant drives available, but 
we like the design here: The plug you insert into the drive’s 
USB-C port is built into the bumper’s back edge, so it’s 
unlikely to be pulled out of the drive’s body if the back 
happens to scrape a surface during a plunge, say; on 
some alternatives, the whole panel pulls out.

Speeds are close to other USB 3.1 Gen 2 drives with one 
SSD inside, and within low double digits of Samsung’s T5. 
We got mean averages of 437.2MB/sec reading and 415MB/
sec writing, and peaks of 521 and 501.8MB/sec respectively.

THE BOTTOM LINE. Purposefully bulky for protection and 
a solid performer, the Tu  SSD is a practical purchase if you 
shoot video outside, miles from home. ALAN STONEBRIDGE

The Koogeek Smart Light Bulb is simple to set up 

and control via iOS. Unlike some smart bulbs, the 

Koogeek doesn’t require any additional hardware.

Getting started is easy thanks to built-in 

networking hardware. To connect the bulb, turn it 

on and snap a photo of the bulb’s HomeKit code 

with the Home app. Just a few seconds later, you 

can be swapping colors and fiddling with the 

brightness using an iPhone. Koogeek has an app, 

but it doesn’t offer much additional functionality.

The bulb can create any of 16 million colors, and 

offers plenty of customization for just the right 

shade and brightness. But at 500 lumens, it’s an 

accent light rather than primary light source. 

At $40 a pop, this bulb costs more than other 

smart bulbs that offload electronics to a separate 

bridge. If you need only a few, the math or 

convenience factor may work out in your favor —

but more elaborate lighting setups may be more 

practical with a different brand of smart bulb. 

THE BOTTOM LINE. Costs more than the 

competition, but built-in hardware makes setting 

up easier. RAY AGUILERA

CalDigit Tuff 1TB
Go big on space, speed, and safety
$400  From CalDigit, caldigit.com

Features USB-C (USB 3.1 Gen 2) port, IP57 water resistance

Koogeek bulb
HomeKit-enabled smart bulb
$39.99  From Koogeek, koogeek.com

Needs iOS 8.1 or later

CALDIGIT TUFF

  Plug feels secure in the USB-C port

  Tough protective case included

  Matches other good drives on speed

  Undeniably (yet understandably) bulky

EXCELLENT 

KOOGEEK BULB

  Easy to set up, even for newbs

  No additional hardware required

  Bulb works only on a 2.4GHz Wi-Fi network

  Too expensive for multi-bulb setups

GREAT

Tough testing, trusted ratings
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HIGH-TECH 
PERSONAL 
TRAINING

he gym is the rst port of call 
for most people who want to 
improve their tness, and Apple 
recently unveiled big plans to 
get into the gym business. But 

rather than opening a chain of elegantly 
designed gyms, Apple came up with GymKit, 
a new piece of software that is included in 
watchOS 4. GymKit enables treadmills, rowing 
machines, and other types of tness equipment 
to record data about your workout, such as 
distance, speed, and calories burned, and 
transmit that data direct to your Apple Watch.

Of course, an iPhone or Apple Watch can 
already monitor how far or fast you run when 
you’re jogging or cycling around the park, but 
they’re less useful if you’re simply running on 
the spot on a machine at the gym. But a running 
machine that works with GymKit can use an NFC 
(near- eld communication) chip to record the 

details of your workout in precise detail, 
and then simply push that data over onto 
your Apple Watch.

Apple has announced that it is working with 
all the main manufacturers of gym equipment 
to add GymKit support to its products, including 
Life Fitness, StairMaster, and Nautilus, and 
some of them have even promised to release 
their rst GymKit-compatible machines by the 
end of 2018. However, most gyms tend to update 
their equipment every two or three years, so it 
could take a while for Apple’s new tech to 
reach the majority of US gyms.

WORK IT OUT

If you want to get started a little sooner, then 
there are still plenty of options available for 
taking your training to the next level. 

The Apple Watch does include both heart rate 
and motion sensors, but it’s something of a 

> GET STARTED WITH…

T
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Hit the road, hit the gym — or just stay at 
home and sweat with the latest training tech

BY CLIFF JOSEPH
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A  T R A I N E R  C A N  B E  U S E D 

TO  C O N V E R T  A  B I K E  I N TO 

A N  E X E R C I S E  M A C H I N E 

DO GYMS REALLY NEED GYMKIT?

 It might take a while for new GymKit-

compatible equipment to arrive in your local 

gym. However, many exercise machines 

already include Bluetooth connectivity 

or NFC chips, which enable them to 

communicate with the manufacturer’s 

own apps on iOS and Android devices.

WHAT ABOUT FITNESS TRACKERS?

 Apple Watch includes dozens of 

features that have little to do with 

health or fitness. If all you want 

is a basic fitband that can monitor 

speed, distance, and heart rate, 

there are many cheaper 

alternatives. One of our favorites 

is the Misfit Ray, which starts 

at just $79.99 and looks like 

a friendship bracelet. It doesn’t 

have a screen, but can use 

Bluetooth to send data to your 

iPhone when you get home.

jack-of-all-trades device, so for many sports 
people, a more specialized heart sensor can be 
useful (or just cheaper than buying an Apple 
Watch). Wahoo is perhaps the most well-known 
name here, as its Tickr range of sensors is sold 
in Apple Stores. 

The basic Tickr model starts at just $49.99, 
and provides precise, real-time monitoring of 
your heart rate and calorie consumption. For more 
detailed monitoring, there’s the Tickr X for $79.99, 
which includes additional sensors for running and 
other sports, as well as a special “treadmill” mode 
so that you can use it at the gym as well as when 
you’re running outdoors.
Other a ordable sports tech that comes in at 

under $100 includes devices such as the Tangram 
range of smart jump ropes. The Smart Rope Pure 
starts at $59.95, and includes magnetic sensors 
that can monitor your jump rate and calorie 
consumption, and its Smart Gym app for iOS 
and Apple Watch enables you to program interval 
training routines and other types of workout. You 
can also buy the Smart Rope LED from $79.95, 
which has a series of LEDs embedded in the rope. 
These create a lingering after-image that displays 
your workout data hovering in mid-air as the 
rope spins round and round. 

We’re also fans of the Zepp range of sports 
sensors. Some of these — such as the tennis, 
baseball, and golf sensors — focus more on 
technique, helping you to improve the accuracy 
and precision of your game, but Zepp also makes 
a soccer sensor for $99.99 that you can wear 
inside a special calf sleeve. This monitors your 
performance during a game, and can record data 
such as your sprinting speed, kick speed, and the 
distance covered during a match to see whether 

Concept2 can help track rowing, 

cycling, and skiing with a wide 

variety of gym-style machines.
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Kickr Snap. For an additional $599, you can buy the 
Kickr Climb, an add-on for the Snap that raises and 
lowers the front of the bike to simulate hill climbs. 
The company even makes a range of accessories for 
its tness gear, such as a “desk” stand you can 
place in front of your bike so that you can 
do some work on your laptop while 
you’re exercising on your bike. 
And if that’s too expensive 
for you, both Wahoo and 
Garmin have a range 
of a ordable “cycling 
computers,” starting 
at less than $100, 
that turn your old 
rust bucket into 
a high-tech smart 
bike with GPS 
and other useful 

tness features.

your tness is up to scratch. Zepp also sells a team 
edition for just under $3,000, which includes 32 
sensors and calf sleeves of di erent sizes, a team 
edition charging case, and a carry bag. 

BICYCLE RACE

If you’re willing to spend a bit more money, you 
can buy your own rowing machine or cycling 
machine for use at home. Concept2 is one of the 
main manufacturers in this eld, and its range of 
rowing machines, cycling and “ski-erg” machines 
are great for working on general cardio tness. 
They’re a bit pricey, with the Model D rowing 
machine starting at around $900, and $990 for the 
BikeErg cycling machine, but Concept2’s products 
are used in a lot of gyms as well, and there’s a small 
industry of third-party apps that work with the 
company’s tness equipment. This data can be fed 
into Apple’s Activity and Health apps, of course.

A less expensive option for use at home is a 
“trainer” — a special stand that you can use to 
convert an ordinary bike into a stationary exercise 
machine, which comes complete with Bluetooth 
connectivity for your iPhone. 

Along with its Tickr heart sensors, Wahoo makes 
a number of Kickr Trainers, starting at $599 for the 

iFacts…
1 IN 3

 The number of US adults 

doing the recommended 

amount of physical 

activity every week. 

7.5 HOURS

 The average number of 

hours US children spend 

in front of a screen (TV, 

computer, etc) every day.

28%

 The percentage of 

Americans aged six 

years or older who 

are physically inactive 

— 80.2 million people.

115 MILLION

 Number of US adults 

projected to be obese by 

the year 2030 — half of 

the adult population. 

With clever tech and LEDs displaying 

your data, Tangram has changed the 

face of the lowly jump rope.

Work out with training tech
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Take it to the limit with these smart fitness devices

GARMIN EDGE 20

$129.99

buy.garmin.com

Cheaper than most 

smartwatches, the Edge 20 

is a “bike computer” that 

can add some smart tech 

to your regular bike. It 

includes GPS location 

tracking and downloadable 

route maps, and there are 

a variety of riding modes 

for indoor or outdoor 

use, as well as for the 

cycling track.

1 2 3 4
WAHOO KICKR SNAP

$599

wahoofitness.com

Don’t like cycling in the 

rain? The compact Kickr 

Snap enables you to turn 

an ordinary bike into a 

versatile exercise machine 

to use at home. Use the 

Snap app to monitor speed, 

resistance, and other stats, 

and also program workouts 

and “virtual courses” with 

varying headwind, rolling 

resistance, and grade.

TANGRAM SMART ROPE 

PURE JUMP ROPE 

$59.95

apple.com

Jumping rope is a great 

workout for many sports 

because it improves both 

fitness and footwork. The 

Smart Rope Pure can 

monitor the speed and 

number of jumps, plus 

calories burned, and 

its app enables you 

to program interval 

training routines.

FIVE OF 
THE BEST

APPLE WATCH SERIES 3

From $329

apple.com

Apple Watch Series 3 

is packed with fitness 

features. Along with its 

heart rate sensor and 

accelerometer, it’s water 

resistant for swimming, 

supports GPS for long-

distance running and 

cycling, and boasts an 

altimeter for those hill 

climbs. The cellular 

model starts at $399.
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WAHOO TICKR X

$79.99

wahoofitness.com

Tickr X is more than just 

a heart rate monitor. It 

can also monitor and 

analyze data such as 

cycling cadence to help 

improve technique, or 

ground contact time 

for running. It also has 

a number of indoor 

modes for use with 

running and cycling 

machines in a gym.

5

A
PPARENTLY AIBO IS back. I’ll 
be honest, I had no idea that 
Sony’s adorkable robot dog 
ever went away, but then I’m 

stuck in a ’90s netherworld with 
my bootcut jeans and Bu y box 
set, so culture-lag is inevitable.

Back in the day, I had no idea 
why anyone would want a robot 
dog — “Like, seriously? Stick 
googly eyes on the toaster.” — 
but now I think Aibo might be 
the best pet ever. Would Aibo 
entertain my toddler? Yes. Would 
it pee on the carpet? No. Might 
I enjoy companionship in my 
twilight years without all that 
pesky dog walking? Yes. Do 
I have to worry about being 
partially-eaten by Aibo when 
I nally shu e into death’s 
warm embrace? No! Everyone’s 
a winner! Plus, Sony claims that 
Aibo can learn what makes me 
happy and show “love for its 
owners through lifelike 
expressions and a dynamic 

array of movements,” 
which is frankly 
more than many 
of my other 
potential life 
partners seem to 
have managed.

I sent a Direct 
Message to my brother, a man 
so cripplingly shy that he had to 
move to Japan to avoid talking 
directly to anyone he knows, to 
ask if he’ll be buying a “family 
Aibo” for us all to obsess over. 
He replies “LOL nope!” alongside 
a string of kanji characters that 
I’ll guess translate as “I live in 
a high-tech shoebox and pay 
more for fruit than you pay 
for gas, fool.”

Whatever, we’ll be together 
one day, Aibo. Just you, me, 
and Bu y. While we’re waiting, 
practice your lifelike expressions. 
Can you do I Love You But I’ll 
Never Gnaw On Your Shoes 
Or Corpse? Cool.

JENNIFER PHIN warms to the 
prospect of a robot companion

>SMART HOME LIVING 
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Cable TV subscribers may prefer 
the chatty newscasters that come 
along with reports from The 

Weather Channel, but if you’re looking for 
location-based forecasts without all the noise, 
NextWeather could be your next weather app.

Featuring beautifully animated backgrounds 
and a wealth of data including hourly, daily, and 
weekly forecasts, this Apple TV app enables you 
to track multiple locations at once, and even 
picks up your current location with a tap on the 
Siri Remote. Don’t want the distraction of an 
animated background? Toggle on High Contrast 
Mode and view weather in a static way against 
a stark black background instead.

Free to download, with no in-app advertising, 
NextWeather is also available on iPhone, iPad, 
or Apple Watch, complete with a “feels like” 
temperature display. Fast, elegant, and with just 
the right amount of detail, this is one weather 
app that’s worth installing. J.R. BOOKWALTER

NextWeather
Personal weather channel
Free

Movies Anywhere
Four services in one
Free

Without a Search function, trying to find the movie you want to watch via 

the Movies Anywhere Apple TV app can be quite a frustrating experience.

The simple and clean interface of this weather app has 

animated backgrounds and just the right amount of detail.

The arrival of 

VUDU delivered 

UltraViolet 

movies and TV shows to Apple 

TV, but at the time of writing 

we’re still waiting for Amazon’s 

app, and Google Play remains 

nowhere in sight. This app 

may be a solution. Powered 

by Disney’s KeyChest, Movies 

Anywhere enables you to buy 

movies from iTunes, Amazon, 

VUDU, or Google Play and 

have them show up on all 

four services. Well, almost — 

Hollywood studios Paramount, 

MGM, and Lionsgate, as well 

as smaller independent studios, 

remain firmly on the sidelines.

The Movies Anywhere app 

offers an easy way for up to 

six family members to watch 

your collection, with parental 

controls. But the Apple TV 

version is a bit basic, with no 

way to sort your library; titles 

are instead listed in the order 

they were added, newest first.

Search is also missing, which 

makes finding movies difficult 

with larger libraries. (Oddly, 

these options exist on iPhone 

and iPad.) But the beauty is 

you can still watch from each 

retailer’s own app — which is 

a good thing since the Movies 

Anywhere app lacks 4K HDR 

support. J.R. BOOKWALTER

>>>Home Life
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Navigate the crowded city of Aragon in an 

escape pod in this fast-moving game.

Those willing to pay will be able to view all 

five species full-screen on their Apple TV.

SONY KD-55X720E

$799.99 • SONY.COM

If you’re looking for 4K HDR 
on a budget, look no further 
than this 2017 Android TV 

model. A ordability isn’t the 
only reason to consider this as 

a companion for your new 
Apple TV 4K — it’s also 

attractive in any room, with 
above-average SDR images. 
Just don’t expect reference-

quality HDR and you’ll be ne.

FOSMON MINI WIRELESS 

BLUETOOTH KEYBOARD

$21.99 • AMAZON.COM

This versatile controller 
 o ers a full QWERTY backlit 
keyboard and a touchpad that 
touts Apple TV compatibility 

for Siri-Remote-style 
navigation. There’s also a 
rechargeable battery, and 
enough buttons to make 

Apple’s remote look more 
minimalist than ever.

Make the most of 
home entertainmentIn this game, Aragon is 

the city of the Devil, and 

players must use all of 

their wits and skills to escape from his 

evil clutches. But don’t get the wrong 

idea: Aragon Escaping is a sci-fi themed 

game where you commandeer an 

escape pod and do your best to dodge 

the numerous buildings coming at you.

The 3D graphics are decent, but you 

won’t have much time to enjoy them 

because the gameplay goes fast and 

furious until you smash headfirst into 

a building. It’s a game of reflexes as you 

slide your thumb back and forth across 

the Siri Remote touchpad, trying to get 

as far as you can without a collision.

As in many games of this type, things 

start to get repetitive pretty quickly. 

But for free, it’s certainly worth a look, 

especially when the iPhone and iPad 

versions also come along for the ride. 

J.R. BOOKWALTER

When those 3D-animated 

aquarium apps simply 

won’t do, why not 

download the real thing? Real 

Aquarium features five different 

species swimming in their native 

environment for your viewing pleasure.

The picture quality is pretty decent, 

but there’s no accompanying sound 

or music. The videos also loop, so the 

app soon wears out its welcome. But 

perhaps Real Aquarium’s biggest 

limitation is the fish selection.

There are five species available: 

octopus, scorpionfish, whale shark, 

anemonefish, and stingray. Although 

those are pretty cool options, only one, 

octopus, is available for full-screen 

viewing. The others must be unlocked 

via in-app purchase of $0.99 each or 

$1.99 for them all. So the content is 

fine but, unless you’re prepared to pay, 

we say pass. J.R. BOOKWALTER

Aragon Escaping
Escape if you can
Free

Real Aquarium
Not enough fish in the sea
Free (IAPs)
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Make sure you check 
out these important 
support articles on 
Apple’s website to 
better understand 
the latest features.

LEARN WHAT’S IN THE 

LATEST iOS UPDATES

Apple’s “About iOS 11 

Updates” web page is 

revised to bring you all 

the details each time an 

update is released. See 

bit.ly/ml137ask1.

PROBLEMS ACTIVATING 

YOUR iPHONE?

If your iPhone can’t be 

activated, or an alert 

says the activation 

server is unavailable 

or the SIM card is not 

supported, learn what to 

do at bit.ly/ml137ask2.

GETTING HELP 

WITH USING FACE ID 

ON YOUR iPHONE X

If you need help using 

Face ID to unlock your 

iPhone X, authenticate 

purchases, or sign in to 

apps, or if you’re asked 

to enter your passcode, 

follow Apple’s guide to 

what to do. See bit.ly/

ml137ask3.

Hot topics 
right now 

> Making a dual-boot High Sierra system
I want to try out High Sierra and APFS, but not switch completely yet. 

Could I make my iMac dual-boot using an external SSD?

Email Mac|Life at ask@maclife.com

Yes, but here are two problems: 

Sierra can’t read or write High 

Sierra’s APFS file system reliably, 

and High Sierra does terrible things 

to Sierra’s Time Machine. The latest 

High Sierra installer should do the 

job direct, but consider using a 

bootable USB memory stick to 

ensure everything works well. Use 

DiskMaker X from diskmakerx.com 

or follow Apple’s own instructions 

at bit.ly/bootable_installer.

Restart from that stick, with 

your external SSD connected, run 

Disk Utility from the installer to 

format the SSD as normal APFS, 

then install High Sierra onto it.

Problems begin when you 

restart back into Sierra. Unless 

Apple updates APFS support in 

Sierra, copying files to or from 

APFS under that system is 

unreliable, and you’ll encounter 

errors. Both versions are fully 

compatible with Mac OS Extended 

volumes, though.

High Sierra can damage hidden 

FSEvents data used by Sierra’s 

Time Machine to establish what to 

back up. At best, this will trigger a 

“deep event scan” at Sierra’s next 

backup; at worst it can force a full 

backup, which swallows space on 

Time Machine’s drive.

Although High 

Sierra’s installer 

app should convert 

an external SSD 

to APFS and then 

install macOS 10.13 

on it, a bootable 

USB memory 

stick is usually 

more reliable.

TECH SUPPORT & TECHSPLANATIONS
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Quick-fire 
questions 
& answers
WHAT’S THE BEST WAY 

TO BACK UP AN iPAD?

If you can afford the cost 

and bandwidth, iCloud 

is convenient, but more 

expensive than iTunes. 

iTunes is the quickest 

and most reliable method, 

with your iPad connected 

to your Mac over USB, 

and the Mac in turn backed 

up using Time Machine 

or similar.

WILL iOS 11 CHANGE 

MY FILES IN iCLOUD?

No. If you’ve updated 

to iOS 10.3, your devices 

are already using the new 

file system, APFS, which 

converts files into iCloud’s 

storage format when it 

moves them into iCloud. 

However, some apps 

such as Notes have new 

features in iOS 11 like tables 

(below), and if you use 

them, you’ll need to use 

iOS 11 to access them fully.

Get official documentation at support.apple.com | Get help with hardware at support.apple.com/repair

Apple’s instructions are at 

bit.ly/leave_familysharing 

and bit.ly/changeregion. You 

must first leave the family 

group, even if you’re its 

organizer, although doing so 

will dissolve the group.

Once you’ve done that, 

you should wait for your 

subscriptions to expire. 

Just before that happens, 

download all of your past 

purchases, then change your 

country of residence and 

payment card details.

Of course, this all assumes 

an ordered and planned 

process, which you have 

not been able to undertake. 

Although you can leave 

the family group, you’re 

already unable to download 

past purchases, and the 

change in your card address 

seems to be blocking 

you from changing any of 

the other details for your 

account, in an effort to 

reactivate it.

There doesn’t appear 

to be any way that you can 

circumvent this chain of 

processes now. The only way 

that your account can be put 

back in order is for Apple to 

step in. Keep trying with 

Apple’s iTunes Store support, 

in the hope that someone 

there will escalate your 

problem to a member of 

staff able to rectify this.

> Got lost when moving country
I used to live in Canada, and have recently moved back to the US. My charge card was 

registered to my Canadian address, but has already been changed to my new one in the 

US. With Apple’s Canadian services, I had Apple Music with a family group, which expires 

in three months. Now I can’t change my card details because of that, nor my country of 

residence. In the meantime, I’ve lost access to my music library, can’t make purchases 

from the App Store, and Apple Support can’t help. What should I do?

You can change details for your Apple ID account by tapping the 

top Apple ID item in Settings, but you must stick to Apple’s rules.

Tech Support & Techsplanations
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Encrypted volumes are 

an invaluable feature of 

Apple’s new file system in 

High Sierra, because they 

are able to protect just 

sensitive information.

HOW CAN I MAKE 

TIME MACHINE 

BACKUPS QUICKER?

Backing up to a large, fast 

Thunderbolt RAID array 

helps, but simplest is to 

archive existing backups 

and start a new series on a 

freshly formatted backup 

drive. You’ll be amazed 

how slow large and old 

backup collections become. 

What currently takes 

10 minutes should be done 

in less than a minute.

 

WHY CAN’T 

DISK UTILITY 

FORMAT MY USB 

MEMORY STICK?

Sierra’s Disk Utility often 

returns an error the first 

time you try to format 

drives like memory sticks, 

but usually works properly 

when you repeat the 

action. In High Sierra, try 

unmounting the stick first, 

then select its grayed-out 

entry at the left and re-

partition it to the 

desired format.

Both Sierra and High Sierra alter the timing 

used to connect to Bluetooth devices during 

the startup process. This may result from EFI 

firmware updates, which are applied during 

the upgrade, and the delay is also set in 

NVRAM, although you shouldn’t attempt 

to change it there.

Check that your Mac is running an 

appropriately recent version of its EFI 

firmware. You can find this out by clicking 

About This Mac in the Apple menu, and then 

clicking the System Report button. In the 

Hardware Overview, the firmware version is 

given as the Boot ROM Version, of which the 

last two groups of hex digits give the version. 

Yours should read at least 0118 B42 in Sierra, 

or 0123 B00 after an upgrade to High Sierra. 

A full list is available at bit.ly/efi_firmware.

FileVault’s disk encryption won’t help 

your iMac’s speed, particularly if the 

encrypted startup disk isn’t an SSD. It’s 

worth thinking carefully about whether you 

need the whole disk to be securely encrypted, 

or whether it would be better just to protect 

its most sensitive files. When High Sierra 

is mature enough, you might find that its 

encrypted volume support is both quicker 

and more appropriate for you. If you don’t 

need whole disk encryption, now is a good 

time to get rid of it.

> Slow to start with FileVault enabled
Since I upgraded my iMac Late 2013 to Sierra, it takes a long time to recognize my Magic 

Mouse after startup, and the wireless keyboard is even slower to get going. It doesn’t run 

any old software, but I did convert it to FileVault just before upgrading. Is this just Sierra?
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ARE HIGH SIERRA’S 

ENCRYPTED VOLUMES 

REALLY SECURE?

Yes, although there was 

a bug in Disk Utility which 

revealed the password 

instead of its hint! That 

bug was fixed in the 

Supplemental Update in 

early October, and APFS-

encrypted disks and 

volumes created since 

then appear to be secure.

THE MACBOOK PRO’S 

STARTUP CHIME 

HAS VANISHED

All 2016 MacBook Pro 

models shipped with 

muted startup chimes. 

This was controlled by 

a setting in NVRAM, 

and many users changed 

this to restore the chime. 

However, recent firmware 

updates for High Sierra 

have disabled the chime 

altogether. It sounds like 

it’s gone f  d.

HOW FAR BACK IN TIME 

DO SIERRA’S LOGS GO?

At first, they went back 

only a few days, but 

around macOS 10.12.4 

that was extended to 

20 days or so. Since log 

files stored in /var/db 

are normally backed up 

by Time Machine, your 

system could have a 

complete log record 

dating back to when 

you upgraded to Sierra.

Macs don’t have default 

passwords. Enter your login 

password when prompted 

at startup, ensuring that 

Caps Lock is not engaged 

and stepping through each 

character carefully. 

You can reset your 

password in macOS 

Recovery (hold Cmd+R 

when starting up). Select 

Disk Utility, then open 

Terminal in Utilities. At its 

prompt, type resetpassword 

and press Return. Select 

your startup volume, then 

your normal user account 

when prompted. After 

entering your new password, 

click Save, and restart your 

Mac. You should now be able 

to log into your account 

using that new password.

This gives you an empty 

local keychain. Since you’re 

using iCloud Keychain, open 

iCloud’s preferences pane, 

and ensure that feature is 

on, to give access to all your 

saved passwords. If you can’t 

access iCloud properly, you 

may also need to change 

your Apple ID’s password 

— follow Apple’s instructions 

at bit.ly/appleid_password. 

You should then have two 

main passwords: one to log 

into your MacBook Air, and 

one for your Apple ID to 

access iCloud and other 

Apple services.

> What’s the default password?
After upgrading to Sierra, my MacBook Air has started asking for and refusing a password 

when it starts up, although I use iCloud Keychain. Is there a default password?

Yes, but keep backups in case you need 

access in the future. If you’re not using iCloud 

Keychain, these are stored locally in your 

login keychain, which opens automatically 

when you log in. Never tamper with the 

System or System Roots keychains. 

In addition to your regular Time Machine 

or similar backup, make a copy on an external 

drive of your current login keychain from ~/

Library/Keychains/login.keychain-db, put 

this somewhere safe, then open Keychain 

Access. Ensure that login is selected in the 

upper left list of keychains. It’s clearer to 

work separately with passwords, any secure 

notes, certificates, and keys. To delete an 

item, select it in the main listing and then 

choose Edit > Delete, or Ctrl-click and use the 

contextual menu command Delete “n” (which 

names each item). It’s safe to delete expired 

certificates (those with icons marked with a 

red cross), and any passwords that haven’t 

been modified for a long time.

If you make a mistake you can’t undo, 

make a copy of your backup login keychain 

using a different name, and copy it to your ~/

Library/Keychains folder. Open it, using your 

login password, then copy and paste missing 

items into your current login keychain. Don’t 

worry if your keychain seems large — they 

work fine with over 1,000 items.

> Tidying your keychain
I recently noticed that my keychain holds many passwords, most of which I don’t need. 

Can I delete them, and if so, how?

To sync your Mac with your shared keychain and all its passwords 

and certificates, turn on Keychain in the iCloud pane.

nds like

s gone for good.
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So long as you use a copy of your Entourage 

mailboxes, the repair utility you mention may 

fix your immediate issue. If you’ve already 

tried to get Entourage itself to repair the 

mailboxes and it has been unable to, that’s 

your only serious option.

Microsoft Outlook is quite different, 

and there’s no other mail client which is an 

obvious replacement for Entourage’s rich 

features. Many users were dismayed when it 

was replaced with the cut-down Outlook.

There’s a wide choice of mail client apps 

available in the App Store; visit their makers’ 

websites for demo versions and further 

information about each. Many are also 

offered outside the store, making them 

much easier to try before buying.

For converting your current mailboxes, try 

Emailchemy from weirdkid.com/emailchemy, 

which supports the conversion of database,  

.RGE and cache files to formats that can be 

imported into almost any other mail client.

The longer you postpone making the move 

to a new client, the greater the chances of 

Entourage failing and leaving your mailboxes 

completely unreadable.

This can occur when you convert old 

iPhotos libraries, when another app has 

tampered with the library, or because of 

bugs, but it’s most common when you use 

Copy and Paste to add new images to the 

library, instead of importing them.

Ensure you have a backup of the library, 

so if anything goes wrong you can revert to 

it. Remove images with garbled names, and 

import them from the originals to preserve 

names and other information.

If that isn’t feasible, edit the information 

about each image to add names and other 

details. If neither of these strategies works, 

suspect a problem in that library, and repair 

it. Hold the Opt and Cmd keys when opening 

the Photos app, and accept the offer to 

repair the current library.

> Garbled names in Photos
Some image names in Photos are gibberish. How should I fix them?

HOW CAN I CHECK 

WHAT’S IN AN 

INSTALLER PACKAGE?

When you open a package 

in Installer, File > List Files 

can normally display its 

contents. To find out more, 

use Suspicious Package 

(Free, mothersruin.com), 

which gives full details of 

the package’s contents, its 

installer scripts, and more. 

It also works as a Quick 

Look plugin — to view the 

package, tap the spacebar.

HOW CAN I PUT A 

DIALOG FRONT END 

ONTO A SHELL SCRIPT?

AppleScript has support 

for simple dialogs, or try 

Swift in Xcode, which can 

do almost anything but has 

a steep learning curve. A 

quick, simple way is 

Pashua (Free, bluem.net/

en/mac/pashua), which 

can provide a fairly 

sophisticated front end for 

most scripting languages.

> Moving on from Entourage
We’ve been using Microsoft Entourage 2008 as our email client on our iMac Late 2015 

with Sierra. Entourage, however, seems to be dying. We’ve looked at Outlook 2016, which 

lacks a lot of valuable features, so we don’t want to upgrade to it. Should we use Stellar 

Phoenix Entourage Repair and carry on using the app, or is there something better?

When images in Photos have garbled 

names or info, correct them using the 

Info option and check it works properly.

Before you commit to a new mail client, download a demo of Emailchemy and test migrating your mailboxes.

>>>Ask
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Ask yourself whether you really need them, 

or would find a less invasive alternative 

browser like Firefox to be just as suitable. 

If you can get rid of the other browsers, that 

should free up your Mac’s processor and 

memory capacity.

To remove Opera, you should need only to 

drag the app from Applications to the Trash. 

Chrome, however, is a bit more complicated. 

Quit the app, and drag it to the Trash. 

Then, in Finder, hold Opt and choose Go > 

Library, then open the Application Support 

folder within that location. Move the folder 

named Chrome from the Google folder to 

the Trash. Then restart, and empty the Trash. 

Doing this should clear all related detritus, 

although there may still be smaller files left 

in your user account’s library. Do a final 

check in Activity Monitor to ensure there are 

no processes still running for the trashed 

apps. If there are, you might need to hunt 

those down and remove them too.

Modern browsers are hefty and complex. 

Although it’s often wise to keep one running, 

keeping a second open in addition is likely to 

adversely affect your Mac’s performance.

> Browser helpers hogging the CPU
I currently have Opera and Google Chrome installed as Safari alternatives. According to 

Activity Monitor, their “helpers” are hogging the CPU. Is this normal and necessary?

HOW CAN I TELL WHICH APPS WORK 

IN HIGH SIERRA?

There’s no simple test to tell whether older 

apps will still work in High Sierra. Check each 

vendor’s support pages to see which version 

they deem compatible; upgrade if necessary.

HOW DO I CREATE DVD-VIDEO DISCS 

WITH DATA TOO?

This is basically a regular DVD-Video disc 

with added data files stored in a different 

folder (the video is in VIDEO_TS). Use an 

app such as Toast Titanium from roxio.com.

Our advice may refer to 
the following features; 
check out the support 
articles linked below 
for full instructions.

macOS RECOVERY

The Recovery system 

contains tools to help 

you look up info online 

when macOS won’t start, 

and to repair or reinstall 

the system. Learn more 

at bit.ly/mlrecovery.

SAFE MODE

When you start your Mac 

in Safe mode, macOS 

performs extra checks 

and stops certain third-

party software from 

running. See how to use 

it at bit.ly/mlsafemode.

RESET SMC & NVRAM

These features handle 

low-level functions and 

store key settings for 

your Mac, respectively. 

Resetting them can fix 

various issues described 

at bit.ly/mlresetsmc and  

bit.ly/mlresetnvram.

HARDWARE ISSUES

Your Mac includes tools 

that check for certain 

hardware issues without 

going to a Genius Bar. 

For Macs introduced in 

June 2013 or later, see  

bit.ly/mldiag, otherwise 

see bit.ly/mlahwt.

Essential 
support 
articles

Tech Support & Techsplanations
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Make quick, neat photo cutouts
Use Photoshop selections and masks to get rid of unwanted backgrounds

REQUIRES
Photoshop CC,  

a few test images, 

some patience

YOU WILL LEARN
How to use Photoshop’s 

manual and automatic 

selection tools, even on 

tricky subjects

IT WILL TAKE
From 10 minutes to 

an hour, depending 

on the subject

HOW TO Use selections and masks in Photoshop

Path to success
There’s more than one way to skin this 

particular cat, but we’ll start with the Pen tool, 

which pros favor for sharp cutouts. We traced 

around our furry subject — the path doesn’t 

need to be perfect, just a general outline.

Convert to selection
In the Path window, Ctrl-click your path 

and choose Make Selection. Keep Anti-aliased 

checked, but make sure the feather radius is 

set to zero. Click OK and the familiar marching 

ants marquee appears where your path was.

GENIUS TIP

Take your time! 

Photoshop’s automatic 

tools are no substitute for 

attention to detail and 

making sure you get 

things absolutely right. 

Questionable cutouts are 

visible a mile away.

IN PHOTOGRAPHY, ISOLATED

subjects, alone on a sea of 
white paper, are a favorite way 
to showcase products or the 

latest fashions, and can look spectacular. 
The easiest way to achieve this is to shoot 
your subjects in a studio environment, 
against a clean, white backdrop — this 
gives you the smallest amount of work 
to do afterwards.

However, that’s often easier said 
than done. Some subjects are too large to 
accommodate even in a big studio, others 
too restless. Or you might simply have 
photographed something in the outside 
world and want to remove a distracting 
or otherwise inappropriate background. 

So, while capturing your subjects against 
plain backdrops is the ideal situation, it’s 
not always achievable, which is where 
Photoshop can come to the rescue.

Photoshop’s options for cutting 
subjects out of their background are 
constantly evolving, from simple marquee 
selections years ago to the advanced 
edge-detection technology available now, 
which can help you achieve impressive 
results with indistinct edges such as hair 
or fur, and even semi-transparent areas 
such as smoke and clouds. The best 
approach is to use both old-school and 
new-fangled techniques hand in hand, 
which Photoshop’s Select and Mask tools 
allow you to do. DAVE STEVENSON

HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD

CREATE
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Select and Mask
Press Cmd+Opt+R to open the Select 

and Mask workspace. The first slider in the 

panel is Transparency. Drag this to the right to 

preview how your cutout looks. Right now it’s 

pretty rough and ready, with no fine fur detail.

So refined
Press R to select the Refine Edge tool, 

tap the left or right square bracket key to get 

the brush a good size to work with, and paint 

around the outline. Photoshop will detect the 

fine edge detail and add it to the selection.

JARGON BUSTER

In Photoshop, a mask is 

effectively a hole in a 

layer that allows you to 

see the layers beneath. 

It’s useful here because 

it doesn’t throw the rest 

of your layer away once 

you’ve cut your subject 

out, leaving you room 

for maneuver later.

QUICK LOOK Better selections and cutouts

QUICK SELECTION
The Quick Selection Tool 

(W) is a fast way to begin, 

especially for objects with 

distinct outlines and good 

contrast from the setting.

PREVIEW OPTIONS
There’s a range of ways 

to preview your selection. 

Try more than one to see 

which suits your image 

best and check your work.

EXPERT OPTIONS
There are numerous 

options for smoothing and 

feathering the edges of a 

cutout, decontaminating 

colors, and much more.

REFINE EDGE
The Refine Edge tool 

is the star of the show. 

Simply brush over areas 

to fine-tune the cutout. 

Find out more in step 4.

PAN AROUND
In Select and Mask panel, 

just as in other parts of 

Photoshop, you can zoom 

in or out, and pan around 

using the Hand Tool (H).

How to do anything on your Mac, iPhone & iPad
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Going manual
Here, Refine Edge has failed us and left 

a bit of our infant monkey’s head transparent. 

Fix things like this manually — press B to switch 

to the Selection Brush, then paint the selection 

area back in. Again, a soft brush works best.

Fine-tune and export
Use progressively smaller brushes to 

refine your work, then decide how you want to 

export the cutout in Output Settings. Selection 

(marching ants) is the most basic; a new layer 

with a layer mask is the most flexible.

Paint away
Here’s the Refine Edge tool at work — 

as we painted around the monkey’s previously 

roughly cut head, Photoshop has automatically 

detected and added tons of fur detail. Work 

around the rest of the outline of your image.

Check your work
Press K to view an outline of the 

selection on a plain black background. You 

should see plenty of fine detail and no hard 

edges. If you see any of the latter, go back over 

the area with the Refine Edge brush to fix it.

Smear attack
The top of our monkey’s head has a 

“halo” of the old background around it, which 

will look like a smear. Select the Brush tool (B), 

hold Opt so your brush will remove areas from 

the selection, and paint out all the smears.

Corrections
Using a soft brush, work in small areas, 

and check the results before moving on. Step 

back by pressing Cmd+Opt+Z, and redo strokes 

with Cmd+Shift+Z. Zoom in (press Cmd and +) 

and vary brush size to get fine detail right. 

REFINE MASKS 
MANUALLY

If you’ve saved your 

selection as a new layer 

with a mask, remember 

that you can retouch the 

mask manually at any 

time. Opt-click the mask 

thumbnail in the Layers 

panel to edit it directly in 

the main image window.

GENIUS TIP

Here’s a pro trick: use 

adjustment layers to 

temporarily increase the 

contrast in the image or 

apply any other changes 

that make it easier to 

create the selection you 

need. When finished, 

simply remove the 

adjustment layers.

>>>Create
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GENIUS TIP

VirtualBox enables you to 

create snapshots of your 

virtual machines, 

recording their state at a 

point in time for easy 

restoration — more at  

bit.ly/ml137vbsnap.

VIRTUALBOX IS A free app 
with which you can create 
a Windows 10 “virtual 
machine.” This means you can 

run Windows, use programs written for it, 
and share les from the comfort of your 
macOS desktop. In order to proceed, all 
you need to do is buy a Windows 10 DVD 
or download an ISO le, and obtain a valid 
product key for your chosen version.

Our guide also contains tips on 
installing the VirtualBox Extension Pack 
and Guest Additions. These allow for the 
more advanced features that you would 

nd in a physical computer, including 
fullscreen mode (press Cmd+F to switch 
to it) and support for USB devices. 

Once you’ve followed our guide and 
everything works, check out VirtualBox’s 
Devices menu for more hidden treasures. 
Choose Devices > Shared Clipboard > 
Bidirectional to be able to copy and paste 
text between macOS and your virtual 
Windows machine.

Run Windows 10 on your Mac desktop
Use VirtualBox to create a virtual machine window on your macOS desktop

You can drag-and-drop to move les 
and folders between systems. PCs are 
more prone to malware than Macs, so you 
may want to make this one-way with the 
“host to guest” setting. For further peace 
of mind, you can choose to share only 
speci c folders from your Mac, such as 
Downloads. Pick Devices > Shared Folders 
> Shared Folders Settings to add a speci c 
Mac folder. You’ll then have access to 
your designated folders in Windows’ File 
Explorer under Network > VBOXSVR. 
NATE DRAKE

REQUIRES
VirtualBox, Windows 10 

DVD or ISO image

YOU WILL LEARN
How to install Windows in 

VirtualBox and use the 

app’s advanced features

IT WILL TAKE
At least 60 minutes

You can access shared Mac folders under Networks in 

Windows; right-click to create a desktop shortcut.

>>>Create
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Configure storage
Leave the default “Hard disk 

file type” selected and click Continue. 

Do the same for “Storage on physical 

hard disk” by clicking Continue again. 

Choose the size and location for your 

virtual disk, then click Create.

Install Virtual Box
Open your web browser and 

visit virtualbox.org to download the 

software. After installing the app, 

return to its site, click “All supported 

platforms” next to “VirtualBox 

Extension Pack” and install that, too.

Set up Windows
When the virtual machine 

opens, dismiss alerts about mouse and 

keyboard integration. At “Where do 

you want to install Windows,” pick your 

virtual disk and click Next. Continue 

setup as you would on a regular PC. 

Add media
Choose Machine > Settings, 

then click Storage. Select the CD in 

the Storage Devices tree, then click 

the CD icon, and then either your DVD 

drive or Virtual Optical Disk File and 

your Windows 10 ISO file. 

Get Windows
To proceed, you need a DVD or 

ISO image of Windows 10. ISO images 

are available at bit.ly/mf320virtualbox. 

You must enter a valid product key 

within 90 days of installing Windows 10 

in order to keep using it.

Guest additions
Once Windows’ desktop 

appears, choose Devices > Insert Guest 

Additions CD image. Go to that CD in 

File Explorer and run VBoxWindows 

Additions.exe to install extra features. 

Select Reboot Now and click Finish. 

Attach USB devices
Connect a USB device to your 

Mac, but ensure you eject it in Finder 

before proceeding. While your virtual 

machine is running, go to Devices 

> USB and select your device there to 

make it available to Windows.

Add USB support 
Click Ports and then the USB 

tab. Click the blue icon at the top right 

of the device filters box to add one or 

two empty filters; this enables you to 

connect USB devices to Windows. Click 

OK to save settings, and then Start. 

Set virtual machine 
Click New at the top left of the 

app. Next to Name, enter “Windows 10,” 

and click Continue. Adjust the slider 

on the Memory Size page to allocate 

at least 2048MB of memory to your 

virtual machine.

HOW TO Set up VirtualBox

How to do anything on your Mac, iPhone & iPad
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GENIUS TIP

If you archive a chat 

by accident, enter the 

contact’s name in the 

search bar, click the arrow 

next to “Archived,” then 

select “Unarchive chat.”

WHATSAPP HAS RELEASED

the latest version of the 
desktop app for its immensely 
popular messaging service. 

You can get started by simply using your 
cell phone to scan a QR code and load 
your contacts, conversations, and media 
straight into WhatsApp Desktop.

The advantage of using WhatsApp 
on your Mac is that you can use a regular 
keyboard to type. It’s also much easier 
to send photos and videos from your 
computer straight to your contacts, 
simply by clicking the paperclip icon. 
This bene t works both ways — click 
the pop-up menu at the top right of 
the window to view info about a contact, 
including les they’ve shared with you, 
then save them to your Mac. If you leave 
WhatsApp Desktop running in the 
background, macOS will display pop-up 
noti cations for messages.

WhatsApp Desktop is not a substitute 
for the cell phone app: it communicates 

Use WhatsApp on your Mac
Bring the popular, cross-platform mobile messaging app to your desktop

directly with your cell, which must be
connected to the internet via Wi-Fi or 
a cellular data network at all times. 

The app keeps your conversations 
safe using end-to-end encryption, 
and it’s worth noting that iPhones 
are considerably harder to hack than 
computers. Of course, with the app 
running, anyone with access to your 
user account can read the messages on 
your Mac, but you can reduce this risk by 
logging out when you’re done on your Mac 
instead of staying signed in. NATE DRAKE

REQUIRES
A mobile device running 

WhatsApp, OS X 10.9 

or later

YOU WILL LEARN
How to connect to 

WhatsApp Desktop, and 

configure your profile 

and chats

IT WILL TAKE
10 minutes

The WhatsApp Desktop app makes life very easy 

when you’re sending and receiving attachments.

>>>Create
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Compose message
If you want to compose a new 

message to a WhatsApp contact, click 

the new message button at the top left. 

Select your chosen WhatsApp contact 

and enter a message in the text box 

as outlined above. 

Pair with your cell
When you first open WhatsApp 

on Mac, you’ll see a QR code. Use the 

WhatsApp mobile app to scan this: On 

an iPhone, go to Settings > WhatsApp 

Web/Desktop > Scan QR Code and point 

the rear camera at your Mac’s screen.

Change wallpaper
Click the downwards-pointing 

arrow, choose Settings, and this time 

click Chat Wallpaper. Move the pointer 

over the swatches on the left side to 

preview colors in the conversation on 

the right, and click one to select it. 

Manage profile
Click your profile image to view 

your profile details. Click your photo to 

remove it, or to take or upload another. 

Click the Edit icon (the pencil) next to 

Your Name to amend it, or the same 

icon next to About to change details.

Stay signed in
The WhatsApp welcome screen 

contains a checkbox marked “Keep 

me signed in.” Choose this to keep 

your cell phone or tablet connected to 

WhatsApp Desktop. Your mobile device 

must remain connected to the internet.

Organize chats
In the view that shows chats 

on the left and the selected one on the 

right, Ctrl-click a chat in the list. You 

can archive it, or delete it altogether. 

Alternatively, select Pin Chat to keep 

that conversation at the top of the list.

Log out
Staying signed in means anyone 

with access to your user account on 

your Mac will be able to view and send 

messages. So for privacy, click the 

downwards-pointing arrow again when 

you’re done and choose “Log out.”

Edit notifications
By default, the app will display 

a pop-up notification when someone 

sends you a message. To change this, 

click the downwards-pointing arrow, 

and choose Settings in the menu. Click 

Notifications to modify their setup. 

Start chatting
Once you’re signed in to 

WhatsApp, you’ll see an interface 

very similar to the one on your device. 

Click on existing conversations on the 

left, and chat using the text box at the 

bottom right. Press Return to send.

HOW TO Master WhatsApp Desktop

How to do anything on your Mac, iPhone & iPad
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WHAT’S BETTER THAN having 
an app able to handle whatever 
kind of le you want to open? 
Answer: having a choice of 

ways to run your apps. Such exibility 
is one of the characteristics of the Mac, 
enabling it to suit whatever you need to 
do right now or the way you like to work. 

So, to nd an app you want, you can 
browse the Applications folder in Finder, 
and create desktop aliases or add favorites 
to the Dock for easy access. If you’re more 
familiar with iPad or iPhone, the macOS 
Launchpad presents large app icons in an 
iOS-like grid. You can use Spotlight or Siri 
to nd apps for you. To open a le with a 
speci c app, drag-and-drop the le onto 
the app icon or alias in Finder or the Dock.

At the other end of the scale, you can 
use the Terminal utility to launch apps 
from the command line, or to open les 
with a speci c app. To run an app, type 
the open command: for example, open/
Applications/Mail.app. Add -a to open a 

Opening apps on your Mac
Explore the many ways to open your preferred software

named le with a speci c app: open -a 
Preview ~/Pictures/pumpkins.jpg.

If you’re a keyboard fan but don’t feel 
ready for Terminal commands, consider 
setting up app shortcuts to open selected 
items using a key combination. To do this, 
create a Service using Automator, another 
tool that comes free with your Mac, then 
set up a keyboard shortcut for the Service 
in System Preferences (see steps 8-9). 

How about not having to open apps 
yourself at all? You can con gure your 
Mac to open speci ed apps automatically 
when you log into your user account, so 
they’re already running when you need 
them. Go to System Preferences > Users 

 Groups, and click the Login Items tab 
for your user account. (You can also do 
this for other user accounts you manage.) 
Click the plus sign beneath the right-
hand pane to add an app. Click the Hide 
checkbox next to an app if you want its 
windows to be hidden even though it has 
launched in the background. NATE DRAKE

REQUIRES
macOS 10.12 or later. Siri 

requires internet and 

a microphone

YOU WILL LEARN
Various ways to launch 

apps quickly and easily

IT WILL TAKE
10 minutes

>>>Create
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Launchpad
Launchpad works like an 

iPhone’s Home screen. Click its icon in 

the Dock or use Spotlight to open its 

icon grid, then click the app you want. 

You can drag icons to rearrange them 

across multiple pages and in folders.

Use Finder
To open apps in Finder, simply 

click the Finder icon in the Dock (it’s 

always there, on the left), then click 

Applications in the sidebar — if this is 

hidden, go to Finder > Preferences > 

Sidebar — and double-click an app icon.

Ask Siri
Click Siri’s icon in the Dock or 

menu bar and enable Ask Siri. Now 

click either icon again or hold down 

Cmd+space to open Siri and try saying 

commands, such as “Launch Mail.” You 

can disable Siri in System Preferences.

Make a service
Open Automator and create a 

new Service document. Change the 

“Service receives” item to “no input.” 

Drag Launch Application from the left 

to the right pane. Select your app in 

the pop-up, and press Cmd+S to save.

Apps in the Dock
The Dock provides single-click 

access to your favorite apps. To tell 

your Mac to keep an app there, Ctrl-

click the app’s icon and pick Options > 

Keep in Dock. You can drag any app’s 

icon from Finder straight into the Dock.

Open With
Double-clicking a file opens the 

app set as default for that type of file — 

to set this, Ctrl-click it, select Get Info,  

pick an app under Open with, and click 

Change All. To open a file in a different 

app, Ctrl-click and use Open With.

Use aliases
For fast access to an app, create 

a shortcut to it. Hold Opt+Cmd and 

drag the app icon to your desktop or a 

folder; the arrow on the pointer shows 

it will create an alias when you let go. 

To open the app, double-click the alias.

Assign a key combo
Name your Service, and press 

Cmd+C to copy the name. Go to System 

Preferences > Keyboards > Shortcuts > 

App Shortcuts. Click +, paste the name, 

click the shortcut box, and press your 

desired key combo. Finally, click Save.

Use Spotlight
You can use Spotlight to search 

for apps wherever they are on your 

Mac and open them. Press Cmd+space 

to reveal its search bar, then type an 

app’s name. Use the arrow keys to 

select the app; press Return to open it.

HOW TO Open apps using a variety of methods
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Enable “On My Device”
Your iOS device is not included as a 

Location in the Files app right away. So in any 

app (say Photos), pick a file, tap its Share icon, 

and swipe to the left in the bottom row of 

options until you see Save to Files, then tap it.

Save a file to enable
Next tap “On My iPhone/iPad.” You can 

save only into your existing Pages, Numbers, 

and Keynote folders, so pick any of these and 

tap Add. Now when you open the Files app, 

your device appears in the list of Locations.

WHEN THE NEW Files app was 
announced, it sounded like an 
iOS equivalent of the macOS 
Finder, enabling you to view 

and organize all the les on your device. 
It isn’t quite that. For a start, your les 
are not all visible in Files unless you add 
them to the app; you can’t even see your 
device among the default Locations until 
you add at least one le to Files.

Once you start using it, though, the app 
does give you a convenient central point 
from which to view and manage your 
iCloud Drive, Google Drive, Dropbox, and 
other cloud storage locations, as well as 

les on your device (after you’ve pointed 
the app at them, anyway). You can move, 
rename, and organize les, sort them by 
name, date, size, or custom tags you’ve 
added, and more. 

The bonus is that if you have Pages, 
Numbers, and Keynote documents stored 
in iCloud Drive, the Files app also enables 
you to collaborate on these with other 
people, in real time. Here we’ll show you 

Master the iOS 11 Files app
Manage files in various locations, and work remotely with other people

how, and explain some of the app’s quirks 
and foibles. Note that some devices o er 
extra options — drag-and-drop on iPad, 
for example. ALEX SUMMERSBY

CREATE NEW 
FOLDERS

 

On the Files app’s main 

Browse screen, tap the 

Location where you want 

to add a folder. If it’s “On 

My [Device],” you can only 

add subfolders, not top-

level folders, so next tap a 

folder. Drag the screen 

down slightly and tap the 

“New Folder” icon at top 

left (the folder with a plus 

sign on it — if you don’t 

see this or it’s grayed out, 

the cloud service you’ve 

chosen doesn’t support 

new folders). Name your 

new folder and tap Done.

REQUIRES
iOS 11

YOU WILL LEARN
How to make use of the 

new Files app to manage 

documents stored in the 

cloud or on your device, 

and how to collaborate on 

them with other people.

IT WILL TAKE
5 minutes

HOW TO Manage and share documents using the Files app

iOS
L E A R NL E A R N

11
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Add other services
Install other cloud storage apps and 

set them up, then open Files and tap Edit (top-

right of the main Browse screen). Activate (or 

hide) the Locations you want, and change their 

order by dragging them up or down the list.

Recents and Favorites
Files you’ve accessed in Files get added 

automatically to Recents, so you can access 

them again super-quick. For fast access to 

folders, add them to Favorites — tap and hold 

on a folder, and select Favorite in the pop-up.

Collaborate with others
With a Pages, Numbers, or Keynote file 

in your iCloud Drive, you can also invite other 

people to work on it with you. At the foot of 

the Share sheet, tap Add People, pick how to 

send invites, then tap Share Options below.

Using tags
To duplicate, rename, move, delete, or 

share a file, tap and hold on it and pick the task 

you want in the pop-up. Select Tags to apply a 

tag (or several), then find files with a given tag 

fast by tapping the tag on the Browse screen.

Share files
Tap and hold on a file and select Share, 

or alternatively tap Select (top-right), tap a file 

or multiple files to select them, then hit the 

Share icon at bottom-left. You can share in all 

the usual ways — AirDrop, Message, and more.

Set access levels
Set who can access the file and what 

they can do. With the settings shown, invitees 

who sign in can all see everyone’s changes in 

real time, color-coded so you know who’s done 

what. Learn more at bit.ly/iwork_collaborate.

DELETE AND 
RECOVER

Deleting a file or folder 

in Files doesn’t trash it at 

once, just move it (and in 

the case of a folder, all its 

contents and subfolders) 

into the Recently Deleted 

folder. It will be deleted 

for good after 30 days 

(sooner in the case of 

some cloud services), but 

if you change your mind 

in the meantime, you can 

tap and hold on it and 

select Recover.

ADD, MOVE, COPY

You can add more files 

to a folder using Save to 

Files (see step 1) or using 

drag-and-drop on an iPad. 

To move files elsewhere 

in Files, drag-and-drop on 

iPad, or tap-and-hold and 

select Move. Note, though: 

If a file is on your device 

and you want to move it 

to iCloud, selecting Move 

will not move it but copy 

it. If you’re sure you don’t 

need the original anymore, 

you can then delete it 

yourself, leaving the copy.
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MANY PEOPLE WILL have 
taken out a subscription to a 
service only to nd they don’t 
use it so often. It makes sense 

to cancel any you’re not taking advantage 
of. Here we’ll show you how to amend 
your Apple Music, Spotify, or Apple News 
subscriptions, for instance, and put a stop 
to little-read newspaper subs and ongoing 

payments to apps. Be warned, some 
subscriptions renew if you don’t cancel 
within 24 hours of the renewal date, 
forcing you to pay for an extra period. 
Many people also get caught out after 
signing up for a free trial period of 
a service, only to nd it automatically 
continues (and starts to charge you) when 
the trial period ends. DAVID CROOKES

Manage your subscriptions
Avoid paying monthly for services you are not using

REQUIRES
iOS 11, existing 

subscriptions

YOU WILL LEARN
How to view, amend, 

and cancel existing 

subscriptions associated 

with your Apple ID.

IT WILL TAKE
10 minutes

SUBS NOT 
SHOWING?

If you find that subs you 

expected to see — Netflix, 

for example — are not 

listed, it’s most likely 

because you didn’t sign up 

using iTunes or an app. 

In this case, you’ll have 

to log in to the company’s 

website to view and 

manage your subscription.

CANCEL SUB
If a Cancel option is available, 

clicking it will be bringing your 

current subscription to an end. 

PAYMENT TIERS
You may decide you want to 

keep your existing membership 

but move to a different tier of 

payment. If this is the case, 

then you can usually select 

a different option here.

NOTE THE DATE
The display will tell you the date 

on which your actions will take 

effect. Change the payment tier, 

for example, and the new tier will 

come into effect after that day. 

Cancel and you’ll be able to 

access your sub until that day.

VIEW SUBSCRIPTION
Details of your current terms 

are at the top of the Settings 

page for each subscription or 

membership. Here, for instance, 

we have a monthly subscription 

to Apple Music at $14.99.

QUICK LOOK View your subscriptions
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90 FEB 2018  maclife.com



HOW TO Manage existing subscriptions

View Apple ID
A pop-up pane will now appear, giving 

you some options associated with your Apple 

ID. Select “View Apple ID” at the top and you’ll 

be asked to sign in, using either your password 

or Touch ID (or Face ID on iPhone X).

Check your subs
You can now view all your subscriptions 

— active ones are listed first, followed by any 

that have expired. It is possible to resubscribe 

to lapsed subscriptions as well as terminate 

those you no longer want.

Go to Subscriptions
The next page will display information 

associated with your Apple ID. To view your 

subscriptions and memberships, scroll down 

and tap Subscriptions. (If this does not appear, 

you don’t have any active subscriptions!)

Select a sub
Tap one of the subscriptions in your 

list to view its current terms and any available 

payment tier options. Tap Cancel to bring it to 

an end (usually on its renewal date, rather than 

immediately). It will then appear under Expired.

ON YOUR MAC

To view your subscriptions 

on your Mac, open iTunes, 

sign in with your Apple ID, 

and go to Account > View 

My Account. You can then 

manage your subscriptions 

within Settings.

Open Settings app
In order to view your subscriptions and 

make amendments to them, you first need to 

go to the Settings app and tap your name, at 

the very top of the page. This will take you to 

your Apple ID settings page.

Select App Store
Tap the entry for iTunes & App Store 

— you’ll find it in the second group of options. 

On the next page, you need to tap your Apple 

ID. Make sure it is the ID associated with the 

subscriptions that you want to manage.

GENIUS TIP

If you change your 

mind after canceling 

a subscription, find it 

in the Expired section, 

tap it, and reactivate it 

by selecting a payment 

option on the screen.
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QUICK LOOK Workflow’s layout

WHETHER YOU’RE announcing 
an engagement or the birth of 
a child, or just want to send 
your family vacation photo to 

everyone without using Facebook, copying 
and pasting a templated email and lling 
in the blanks is a chore on a Mac, never 
mind on iOS. There is a better way.

If you’ve used the free Automator 
utility that’s been included with macOS 
for years, you’ll nd the basic principles 
of Work ow for iOS are similar. If not, 
in summary: You assemble actions in an 
order that achieves your particular goal. 
The output of one action can ow directly 
into the next, all working together. As you 
use the app, you’ll see this ow of info 
represented as a line that runs vertically 
from one action to the next

Data doesn’t have to be passed forward, 
though; if the next action in sequence is 
not designed to take the kind of output 
the previous one produces, there won’t be 

Automate announcements
Swiftly send personalized variations of an email to multiple people

a line between them. This doesn’t mean 
the rst action’s result is lost; it’s stored 
and can be retrieved easily. Work ow 1.7 
added a feature called Magic Variables to 
save you e ort — and to make work ows 
easier to read by not having to add explicit 
actions to preserve and retrieve info. 
We’ll use this to piece together an email. 
Once you create this work ow, you can 
save it to reuse over and over!

Before building any work ow, take a 
moment to list what info it needs from 
you or an app, and the steps you would 
perform manually to achieve your goal. 
Our example will ask for a subject line, 
body text (excluding a greeting and 
sign-o ), and a photo attachment. We’ll 
need a list of recipients who are to receive 
an email, with their address in the To eld 
and rst name in the greeting. Familiarize 
yourself with Work ow below, open the 
app, tap Create Work ow, select Normal, 
and then read on. ALAN STONEBRIDGE

REQUIRES
An iPad or iPhone, 

Workflow 1.7 or later

YOU WILL LEARN
How to use Workflow to 

send the same email to 

a list of people, but with 

a personal touch

IT WILL TAKE
45 minutes

ACTIONS LIBRARY
Actions that Workflow can 

automate are listed on the 

left. Tap Actions at the top 

left to browse the actions 

library by category.

INPUT & OUTPUT
Tap an action in the left 

pane (or its title on the 

right) to see what input 

it can take from the last 

action or pass to the next.

AN EMPTY
WORKFLOW

In the right-hand pane 

you assemble the actions 

that define your workflow 

and achieve your goal. 

WORKFLOW 
SETTINGS
Tap this gear to change 

your workflow’s look on 

the app’s opening page 

and the Home screen.

>>>Create

92 FEB 2018  maclife.com



A safety check
Before you construct your 

email, take a look at your selected 

contacts and check whether any of 

them has no email address. Add the 

“Find Contacts” action; you can use it 

to filter out inappropriate contacts.

Start with a subject
Type “ask” in the search bar 

(top left), and drag “Ask for Input” 

from the results into the pane on the 

right. Set the question to “What’s your 

message’s subject?” Leave the answer 

empty, and set the input type to Text.

Get the addresses
Note the line between actions, 

from Select Contact all the way into 

the Repeat loop: Each time the Repeat 

loop begins, it will take a new contact 

from those it receives. Add “Get Email 

Addresses from Input” to the loop.

Filter contacts
A line shows this gets contacts 

from the last action. Tap Add Filter, 

then tap Group and pick Email Address, 

change “is” to “contains,” and replace 

“anything” with “@.” People with no 

email address will be discarded for now.

Set the body
Add a second “Ask for input” 

action below the first. Set its question 

to “What is its body (without greeting/

sign-off)?” and the answer and input 

type as before. It’s correct that no data 

is passed down to this action.

Multiple addresses
The items now at your disposal 

are email addresses belonging to the 

contact being dealt with. If the contact 

has several, you want to choose which 

to use. Add the “Count” action within 

the loop, and set it to count items.

Check for multiples
Add an “If” action next in line. 

This adds three bars: If, Otherwise, and 

End If. In the first, set the condition to 

check if the received number is greater 

than 1. If so, you’ll need to perform an 

extra action to offer a choice.

Repeat action
Next, add a “Repeat with Each” 

action. Between the two bars this adds 

to the workflow, you’ll use several 

actions to send the same overall 

message, yet personalized, repeating 

until all contacts have been sent one.

Select pic & people 
Find and add a “Select Photos” 

action at the bottom of the workflow. 

Our example allows attachment of 

one image. Find and add the “Select 

Contact” action and set it to allow 

multiple people to be selected.

HOW TO Automate mail merge for emails
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Check input & output
Tap the If action’s title and you’ll 

see that it passes forward its input — the 

quantity of email addresses. You need 

the actual email addresses — use a Magic 

Variable: Add the “Get Variable” action, 

and tap Choose Variable.

Personalized prompt
It may not be obvious exactly who 

an email address belongs to, so let’s 

tailor the prompt with the name of the 

person being emailed on this pass 

through the Repeat loop. Tap the Repeat 

Item token in the keyboard’s top row.

Use a Magic Variable
Next, tap Magic Variable. All of the 

actions in the workflow will spread out 

a little, with pill-shaped tokens between 

them. Find “Get Email Addresses from 

Input” in the workflow, and tap the token 

labeled Email Addresses just below it.

What’s substituted?
After you insert the token into the 

prompt, it’ll be selected and a contextual 

panel will appear at the bottom of the 

screen. That panel should indicate that 

the contact’s full name will be used in 

the token’s place when the action runs.

Choose an address 
To list those addresses so you can 

choose one, add the “Choose from List” 

action. Ensure Select Multiple is off, then 

set the action’s prompt to “Use which 

address for ?” and place the insertion 

point right before the questionmark.

With one address
If the contact has only one email 

address, the workflow will proceed along 

the If action’s Otherwise branch instead. 

In that branch, we need only to retrieve 

that address, so add a “Get Variable” 

action just below the Otherwise bar.

> MAGIC VARIABLES EXPLAINED

An easy way to retrieve an earlier action’s output

Magic Variables enables you to refer back to earlier actions’ results. This can also 

be done using Set Variable and Get Variable actions to store and retrieve results, 

but Magic Variables reduces the number of explicit actions in a workflow, helping 

to make things easier to understand. Tap where you need to use a result, then tap 

the magic wand icon above the keyboard. Tokens representing actions’ results 

appear between the actions; tap one to use its result at the insertion point. Tap 

the token in that place and a panel at the bottom of the screen will open, showing 

what info from the retrieved result will be used — you’ll see an example soon. You’ll 

also find a Rename option above the keyboard for assigning a meaningful name, 

and Reveal Action to check where the result is from. When done, tap Go Back.
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Retrieve the address
Tap Choose Variable in the action 

and choose Repeat Item; it’ll appear as a 

token within the action. Tap that token to 

be presented with a list of info that can 

be retrieved from the item (a contact). 

Choose “Email address,” then tap Done.

Add prewritten body
Remove “Two” from the second 

row to serve as a blank line in our email. 

Add a third row and set its contents to 

a Magic Variable containing the second 

“Ask for Input” action’s result. Rename 

the variable “msgBody” for clarity.

Check your work
Check that you have two actions 

(“Get Variable” and “Choose from List”) 

between If and Otherwise, and only “Get 

Variable” between Otherwise and End If. 

The result that will be passed forward 

now will always be a single email address. 

Sign off your email
Add another blank item, then add 

two more for “Kind regards,” and your 

name, for example. Add one last item 

to the list: make it a Magic Variable that 

takes the output of the Select Photos 

action, and rename that “Photo.”

Send the email!
Add Send Email next. Let it show 

its Compose sheet until you’ve tested the 

workflow. In the “To” row, add a Magic 

Variable for the result below “End If”; call 

it “msgRecip”. In Subject, add the very 

first action’s result; call it “msgSubject.”

Start composing 
We have all the info we need for 

our email. Below the End If bar, add a 

List action. Replace its first item with 

“Hi” followed by a Magic Variable; use 

the techniques you already learned to set 

it to Repeat item’s first name attribute.

> FINISHING TOUCHES

Gain certainty about recipients

It would be useful if your workflow confirmed whether it was unable to send an 

email to any of your chosen contacts. Below the End Repeat bar, add a “Get 

Variable” action and set it to get the results of “Select Contact.” Next, add “Find 

Contacts” and set its filter to look for contacts whose email address doesn’t 

contain @. Add a “Count” action and set it to count items (email addresses).

We’ll do different things based on that number. Add an If action and set it to 

“Is Greater Than” and “0.” Under the If bar, add Show Alert with the title “Unable 

to send to…”, a Magic Variable in its body for Find Contacts’ result, and disable its 

Cancel button. After Otherwise, add Show Alert, title it “Success!” and give it a 

suitable message. Now ask friends if you may test all of this using their addresses.
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YOUR APPLE WATCH stores 
personal data, so it makes 
sense to be careful about 
keeping both the Watch and 

the information on it as safe as you can. 
Make sure you use a passcode and set up a 
way to track your Watch if you do happen 
to mislay it. There are also some other 
settings you should pay attention to, such 
as those related to health and tness. 

Make your Apple Watch more secure
Prevent prying eyes from gaining access to info on your Watch

In addition, the Watch and your 
iPhone sync your data, meaning you 
need to consider the privacy on your 
phone too. Since there is always a danger 
that someone could use your Watch to 
buy something with Apple Pay without 
your phone nearby, Watch security is 
something you should take very seriously. 
Luckily, protecting your Watch and your 
data doesn’t take long. DAVID CROOKES

REQUIRES
Apple Watch, iPhone

YOU WILL LEARN
How to master the 

security options for your 

Apple Watch, whether 

directly or via the sync 

process on your iPhone

IT WILL TAKE
10 minutes

UNLOCK WITH iPHONE
For greater convenience, you 

could have your Watch unlock 

whenever you unlock your iPhone. 

If this is something you’d like, 

then just slide this to green.

LONGER PASSCODE
You can use a passcode longer 

than four digits, but in order to 

do this, you have to unlock the 

Watch with your iPhone and input 

the code on there.

SET A LIMIT
Think about it: if someone stole 

your Watch, they could try 10,000 

times to crack those four digits. 

Slide this option to green and 

your Watch will erase all of its 

data after 10 failed attempts.

CHANGE YOUR
PASSCODE
There’s always a chance someone 

can look over your shoulder as 

you tap in your passcode, so 

it’s worthwhile changing your 

passcode every so often.

QUICK LOOK Set a passcode for Apple Watch
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HOW TO Review your Apple Watch’s security

Turn off Fitness data
Privacy settings can be adjusted to 

stop your Watch sharing your motion and 

fitness data. To do this, open the Watch app 

on your iPhone, then tap My Watch > Privacy 

and select “Motion & Fitness.”

Check Activation Lock
Protect your Watch against theft by 

ensuring the Activation Lock is on. Tap “My 

Watch,” select your watch name at the top of 

the screen and tap “i.” If you can see “Find My 

Apple Watch,” the Lock is activated.

Move the sliders
Within “Motion & Fitness” you’ll see 

two options — one that allows the Watch to 

monitor your heart rate and another that 

determines your step and fitness levels. You 

can turn both of these off.

Disable the Watch
If those words don’t appear, see our 

sidebar for how to set up Find My iPhone. Log 

in when prompted, and you can locate your 

Watch on a map, play a sound to help you 

find it, remotely erase it, or enter Lost Mode.

MORE PRIVATE 
NOTIFICATIONS

By default, your Watch will 

show short notifications — 

the name of the app and 

alert type or sender name 

— but if you keep your arm 

raised, these expand to 

display the contents of 

the message or email. To 

keep things more private, 

open the Apple Watch app 

on your iPhone, tap 

Notifications, and move 

the Notification Privacy 

switch to on. Now when 

you receive a notification 

on your Watch, it won’t 

expand; tap it to reply, 

dismiss, or view in the 

originating app.

Check your privacy
Since your Watch will share the health 

settings, location services, contacts, and 

analytics collected by your iPhone, first make 

sure you lock all these down. Open Settings 

on your iPhone and tap Privacy.

Alter the settings
You can turn Location Services off 

and see which apps request access to your 

contacts and health data. Under Analytics, you 

can turn off “Share iPhone & Watch Analytics.” 

There’s also a “Share iCloud Analytics” option.

SET UP  
FIND MY iPHONE

If your Watch does not 

have the Activation Lock 

activated, then you need 

to set up Find My iPhone. 

To do this, go to Settings 

on your iPhone, tap your 

name at the top of the 

screen, select iCloud and 

scroll down to Find My 

iPhone. Tap it, make sure 

the slider next to the 

feature is green, then 

enter your Apple ID. 

Your iPhone, Watch, and 

AirPods will be set up.
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NEXT 
MONTH 

>>> Celebrate 20 
years of the iMac 

>>> Easy iPhone X 
migration guide 

>>> Fast wireless 
iPhone chargers
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IN THE SPRING of 1983, Steve Jobs 

decided his pet project at Apple — the 

Macintosh — needed a big launch, and 

talked CEO John Sculley into funding 

a pitch from ad agency Chiat\Day for an 

epic ad themed on George Orwell’s 1984. 

British director Ridley Scott — fresh from 

Blade Runner — signed a $600,000 two-

picture deal to produce spots for both 

the Macintosh and the Lisa; the latter 

was directed by Scott’s colleague Adrian 

Lyne (Flashdance, Fatal Attraction) and 

featured a young Kevin Costner (pre-

Untouchables) as a yuppie Apple user. 

The Macintosh spot was less literal: 

hiring a huge studio in Shepperton, 

near London, and dressing it with 

scrap jet engine parts, Scott conjured 

a dystopian scene in which model and 

athlete Anya Major hurled a hammer 

to shatter the screen from which Big 

Brother was addressing an oppressed 

proletariat (Scott recruited local 

skinheads as extras for the scene). It was 

meant to represent fear of technology, 

but when Jobs previewed the ad at a 

Hawaii sales meeting he suggested Big 

Brother was computer giant IBM.

The staff loved it, but Apple’s board, 

led by Mike Markkula, didn’t get it at all, 

and tried to force Chiat\Day to sell back 

the airtime they’d booked, for hundreds 

of thousands of dollars, 

during January’s Super 

Bowl. But it was too late, 

and the ad ran. Sculley 

committed millions more 

to a newspaper ad blitz 

explaining what the 

Macintosh actually was. 

“I remember feeling 

this was a huge project 

for one airing,” film editor 

Pamela Power told me in 2014. A regular 

collaborator with Scott, she cut the 

one-minute spot, shot on 35mm, using 

traditional analog equipment; the Mac 

would later help to revolutionize her job. 

Although it ran only once nationally, the 

ad had been aired on local stations to 

qualify for the 1983 ad awards season. 

It won numerous trophies, including Best 

Super Bowl Spot in 2007, and is widely 

rated the best TV ad of all time.

NEXT ISSUE ON SALE

FEB 06

RANDOM APPLE MEMORY

The 1984 commercial
Adam Banks remembers Apple’s revolutionary ad, which promised 

that 1984 wouldn’t be like “1984”

The ad sees Anya Major hurling a hammer at the screen.
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